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7. Introduction. 

START 2000M ergospirometer is a portable unit  for exercise tests of respiratory 

and circulatory systems held in natural conditions (running, biking, rowing, sailing, etc.) 

during a training, competition, or rehabilitation without loading devices such as ergometer 

or treadmill.  
 

 

 
Figure 1.1a:Ergospirometr START 2000M made by MES Ltd. with additional equipment  

 

  Carry case (1) 

 3 liters syringe for flow, volume and ventilation calibration (in the optional carry 

case) (2) 

 Main measurement unit located in belt’s pocket (3) 

 Wear belt system for  main unit, accumulator, POLAR receiver (4) 

 Terminal replacing PC in extremely hard conditions outside of laboratory 

(option) (5) 

 Dual charger for accumulators (6) 

 Power supply feeder, 230V AC,50/60Hz (for laboratory exercise only) (7) 
 

Thanks to application of a low resistant pneumotach headpiece patented by MES, it 

is possible to measure minute ventilation for many hours. CO2 and O2 analysers and 

wireless pulse recording provide for full recording of the most important ergospirometric 

parameters. START 2000M stores exercise up to 6 hours. The recorded results are 

transmitted to the computer for analysis, graphic presentation, printout , and storage. This 

unit may also be operated in laboratories with direct preview of the measured values. Loads 

may be set on ergometer, treadmill, or other devices. Lab option may be extended with 1-12 

ECG leads with full analysis of values, preview in real time, and storage. START 2000M 

weighs 400g only, equipped with batteries it weighs 500g to 1000g depending on the 

required recording time. START 2000M is held in a special belt, in front or at the back. The 
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unit may be optionally equipped with software for spirometric tests, pulsoxymeter, 

automatic system measuring ambient conditions. Results of spirometric tests are transmitted 

to the ergospirometric system and standard values for minute ventilation and oxygen 

consumption are automatically calculated. 
 

 

 
 

 

1.1b. Start 2000M components. 
 

The Start 2000M system consists of the following elements: 

 Start 2000M Ergospirometer pic. 7.1a  (8) 

 Pneumotachographic Head  (4) 

 Mouthpieces for the pneumotachographic head. 

 Nasal clips 

 Ergospirometric masks with a cap (2) (1) 

 Cylinder with calibration gas. 

 Pressure reducer for cylinder with calibration gas. 

 Cylinder rack. 

 Ergospirometer cable for connection to PC. 

 Pulse sensor of the POLAR type (10) 

 Pulsce receiver (9) 

 Pneumotachographic head connection cable (7) 

 CD-ROM with START 2000M software  

 3-liters calibration syringe 

 Belt for the unit and accumulators uses during tests in the open air 

 Carry-bag for the unit with accesories and notebook 

 Power supply feeder uses for tests in the laboratory 

 Accumulators (12) 

 Dual loader for accumulators 
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7.1c. Start2000M  

 

Ergospirometer. Its view from the left/right  side and in front . 

Start 2000M Ergospirometer is equipped with the following ports and elements:  
1. Socket K1( pic 1.1.), telephone type for connections with RS232 port in PC 
2. Socket K2pic 1.1), telephone type for POLAR connections  
3. Socket Z1( pic 1.1.), for power supply 
4. Mains switch W1 pic. 1.1) to switch on power supply of 230-240V,50Hz 
5. Two connection terminals: S2(FLOW IN) and S1(FLOW EX) ( pic 1.1,) for the 

air cables, to connect the cables from the penumotachographic head connector. 
6. Two connctions terminals( pic. 1.1):G2(Gas IN) and G1(Gas EX) 
7. Three light diodes:LED1,LED2,LED3 

Diode LED1-Status informs about the unit status 
 Continuous red colour- informs that accumulators are low 
 Flicker green colour-gas sensor CO2 warms up( allways after swich on the unit) 
 Continuous green colour- the unit works correctly  
Diode LED2-Puls flickers showing heart beats frequency, if POLAR is connected 
Diode LED3- Expiration lights during expiration phase of breathing patient 

The FLOW EX(S1) connection terminal. One should there connect the cable from 

the pneumotachographic head marked with a black ring. One should connect the other cable 

to the IN connection terminal. 
 The G2 connection terminal is dedicated to connect the gas cable marked with a 

blue ring. The GAS EX(G1) should be open (outlet to the atmosphere). 
  .  

The Start 2000M software that cooperates with Start 2000M ergospirometer enables to 

perform the spirometric examination. The programme interface is presented in pic 1.1.  
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The software allows for determining the following parameters: 

 
BF [1/min]   breathing frequency;  

HR [1/min]   heart rate per minute; 

MET = VO2/kg/3,5  metabolism unit (1MET=3.5ml/min/kg); 

VE [litre/min]  minute ventilation – air volume that the patient's lungs ventilated 

during 1 minute. The parameter is calculated as the product of the 

number of breaths (BF) multiplied by the volume of a single breath 

(TV) measured during the exhalation. BTPS conditions. 

RER = VCO2/VO2  respiratory equivalent;  

TE [s]    exhalation time; 

TI [s]    inhalation time; 

TTOT [s]   total time of respiratory cycle; 

TV(VT) [litr]   volume of a single breath; 

VO2 [litr/min]   oxygen consumption in relation to the STPD conditions; 

VCO2 [litr/min]  carbon dioxide exhalation in relation to the STPD conditions; 

FeCO2 [%]  average value of carbon dioxide accumulation in the expired air. 

The value is calculated for every breath; in case of average 

determination for a given period of time, it is counted as a mean 

value of all the average values of full exhalations in a given period 

of time. 

FeO2 [%]   average value of oxygen accumulation in the expired air  
(value calculated like FeCO2); 

EQO2 = VE/VO2  ventilation oxygen equivalent; 

EQCO2 = VE/VCO2  ventilation carbon dioxide equivalent; 

TI/TE [%]   ratio of inhalation time to exhalation time; 

TI/TTOT [%]   ratio of inhalation time to total cycle time; 

VO2/HR [ml]   oxygen consumption in relation to the frequency of heart rate  

   per minute 

VO2/Kg [ml/kg/min]  oxygen consumption in relation to 1 kg of the patient's body mass 

VO2/Kg/HR [ml/kg]  oxygen consumption in relation to 1 kg of the patient's body  

   mass and the heart rate frequency unit; 

WATT [W]   load; 

PEF [l/s]   peak value of exhalation flow; 

PIF [l/s]   peak value of inhalation flow; 

SpO2    saturation (blood saturation with oxygen); 

VD/VT   ratio of dead space to the respiratory volume; 

PEO2 [mmHg]  average partial oxygen pressure in the exhaled gas; 

PECO2 [mmHg]  average partial carbon dioxide pressure in the exhaled gas; 

BR [%]   breathing reserve; 

VET_SUM [L]  volume of the ventilated air; 

TV_TE [L/s]   ratio of the TV parameter to TE; 

Speed [km/h]   Moving track speed; 

Slope [%]   Moving track slope; 

SBP [mmHg]    value of the systolic blood pressure; 

DBP [mmHg]   value of the diastolic blood pressure; 

Borg    20 point Borg scale with which the patient describes   

   independently their own subjective perception of work exertion; 
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Points Work 
6 Extremely light 

7 

8 Very light 

9 

10 Quite light 

11 

12 Quite hard 

13 

14 Hard 

15 

16 Very hard 

17 

18 Extremely hard 

19 

20 

 

Lactate [mmol/l]  value of lactate concentration in blood; 

TempEx [oC]   expired air temperature; 

HmdEx [%]   expired air humidity; 

HmdExPa [Pa] inspired air humidity(expressed in Pa); 

M [W/m2]     metabolic rate; 

pVO2  anticipated VO2 value calculated on the ground of treadmill 

speed and inclination 

EE    aktualny wydatek energetyczny; 

 

Values describing oxygen debt: 

 

VE.B.SUM [L]  total volume of breaths during the test calculated with the 

reference phase level (tare);  

VE.T.SUM [L]  total volume of breaths during the whole test; 

VE.L.SUM [L]  total volume of breaths during the exertion phases; 

VE.R.SUM [L]  total volume of breaths during the rest phases; 

VO2.T.SUM [L]  total quantity of oxygen used during the whole test; 

VO2.OD.SUM [L]  difference in the quantity of consumed oxygen during the 

exertion phases between the consumption quantities rounded to the 

level of the phase ends and the real values; 

VO2.L.SUM [L]  total quantity of the consumed oxygen during the exertion  

   phases; 

VO2.R.SUM [L]  quantity of the used oxygen in the rest phase; 

VO2.A.SUM [L]  VO2.A.SUM = VO2.OD.SUM - VO2.R.SUM; 

VO2.B.SUM [L]  quantity of oxygen used during the test calculated with the  

   consumption level from the reference phase; 
 

Indirect calorimetry(Nutrition): 

 

REE[kcal/min],[kcal/h],[kcal/day],[kJ/min],[kJ/h],[kJ/day] Resting Energy 

Expenditure 

EE[kcal/min],[kcal/h],kcal/day],[kJ/min],[kJ/h],[kJ/day] Energy Expenditure 
REE/kg,REE/m2,EE/kg,EE/m2 
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BMR[kcal/day] Basal Metabolic 

Rate 
Explanation of the used abbreviations STPD, BTPS, ATP: 

STPD     Standard Temperature Pressure Dry (conditions of dry gas in  

   the temperature of 0 oC and pressure of 760 mmHg); 

BTPS     Body Temperature Pressure Saturated (a man's body   

   temperature, atmospheric pressure and humidity of air saturated  

   with water vapour); 

ATP     Ambient Temperature Pressure (conditions of temperature,  

   humidity and pressure in the room where the test is conducted). 
 

Technical data.  

General data: 
Dimensions (length/width/height)  160/95/60 mm 
Supply voltage     12 V (DC) 

 Power consumption    7 VA 
Accumulator: 
 Output voltage     12V(DC) 
 Capacity     1200mAh 
Accumulator loader: 
 Supply voltage     230-240 V AC, 50Hz 
 Number of loaded accumulators  2 (4-optionaly) 
 

Technical data of the measuring module: 
 

Flow measurement: 
Measurement head:   MES of DV40 type 
Dead space:    38 ml 
Flow range:    +/- 18 l/s 

 Resolutions:    2,4ml/sek 

 Accuracy:    +/-0,3%(of the range) 

 Linearity    <2% 
 Volume measurement range:  0 - 10 l 

Measurement accuracy:   < 2% 
Measurement head resistance: < 0,9 cmH2O/l/s (at the flow of 12 l/s) 
Measured ventilation range:  300 l/min 
 

Oxygen analyser: 
Electrochemical cell 
Measurement range:   0 – 100 % 
Response time:    t90 < 100 ms  
Accuracy:     0,02 %(of the range) 
Resolution:    0,01 % 
 

Carbon dioxide analyser: 
NDIR infrared absorption 
Measurement range:   0 – 10%(0 – 15% expanded range) 
Response time:    t 90< 90 ms  
Accuracy:     0,02 %(of the range) 
Resolution:    0,01 % 
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8. Installation. 

To conduct the examination properly, one need to install the Start 2000M set properly. 

Installation consists in the following steps: 
 

1. From the attached CD-ROM install the Start 2000M programme on the computer: 
 Start the setup.exe file in order to launch the Start 2000M programme 

installer. Install the programme. 
 Reset the computer. 

2. Connect the mains cable to the Z1 port of the device. The other end of the cable 

plug to the mains socket with 230-240 V, 50Hz.  
3. If You cannot find any COM port at Your computer, it will be necassary to use the 

USB/COM adapter. First thing is to install the adapter driver from addlitonal CD. After 

that, You have to plug the adapter to the free USB port * 
4. Connect the cable between port K1 of the device and the RS232 port of the 

computer, or to the USB/COM adapter if COM port is not avaliable. 
5. Connect air tubes for: 

a/ venilation measurement to FLOW connectors S1(EX marked black ring’s) and 

S2(IN)  
b/ gases measurements to GAS connectors G2(IN marked blue ring’s), G1 is free  

6. Connect POLAR to the POLAR socket K2. 
7. Launch the Start 2000M programme from Menu Start -> Programmes or from 

Desktop. 
8. Conduct the examination according to the description from Chapter 12.10. 
9. When there is a communication breakdown between the computer and the 

ergospirometer, one should check the cable connections to the ports (Chapter 5.3) 
 

 

 

*Caution: 

After installation and connecting the USB/COM adapter, it is necessary to check the 

COM number of the adapter. All You have to do, is to find a “Device Manager” in Your 

Windows system, find “COM/LPT ports”. The title You are looking for is “USB-to-

serial comm Port” Write down the COM number. You will need it to set up “The 

hardware configuration” of “Ergo2000M” software. 
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9. Programme interface description. 

 

9.2. Programme interface. 

The programme window is presented in pic. 3.1. It basically consists of two parts 

divided by the so-called splitter. Splitter allows to modify the height of individual parts. In 

order to do this, one should: 

 click on the splitter with the left mouse button; 

 drag it to the desired position;  

 drop the splitter by releasing the mouse button.    
Additionally, interface includes menu ( Chapter 0), toolbar ( Chapter 17) and status line 

( Chapter 0). The window has different toolbars depending on the fact whether the 

programme opened a finished examination from the file, an examination for on-line test, or 

an examination for off-line test.       
The first part includes the views of diagrams of parameters calculated during the 

examination and the the view of on-line processes. The number of both view types is set in 

the programme options ( Chapter 11.3.1). It is possible to have maximum 4 views. They 

are also divided by Splitters. The programme offers a selection of parameters diagrams of 

which we would like to display in a given view ( Chapter 12.5.1.2). The maximum 

number of diagrams in one view is four. Every diagram is in different colour. The diagram 

refers to the parameter whose name (at the top of the diagram) is displayed in the same 

colour as the diagram. Also the colour of scale on the Y axis determines the diagram it 

refers to.  
The programme saves the data collected during the test. After the examination is 

finished, on the current parameter diagrams there appears Scroll, that is a narrow bar at the 

top of the diagram with a bar. By sliding the bar we may display data from any moment of 

the examination. The window width (the length of the time period presented in the view) is 

set in the view settings (Chapter 11.3.1). In the parameter diagram one can also turn off the 

Scroll. One turns it on by a mouse double-click on the view. One turns if off in the same 

way. The slide can also be made with the L (left) and R (right) keys. They slide the diagram 

left or right by a whole window. Active diagram is marked with a blue frame at the top and 

the right side of the view.  
The second part includes a table with the values of the selected parameters from the 

consecutive moments of examination. Which parameters and moments are displayed can be 



Operating manual for Start 2000M ergospirometer 

 15 

set in the table view settings ( Chapter 12.5.4). If the window size exceeds the available 

screen area, there appear in this window scrolls with bars on the right side and at the bottom 

of the window. They allow to slide the window vertically and horizontally so that the 

desired fragment would be displayed. 
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10. Patient's data 

The patient's data is a set of information required for the patient's identification. 

Without this information no examination can be conducted. The patient's data can be 

entered in two ways: 

1. Entering new patient's data ( Chapter 10.1). 
2. Opening the file with the results of examination previously conducted on a 

patient ( Chapter Błąd! Nie można odnaleźć źródła odwołania.). 
After entering the patient's data, the examination will be conducted for this patient. In order 

to examine another patient, first one needs to enter their data.  

10.1. New data 

Patient's new data is entered by means of the dialogue window: Patient's data ( 

pic. 4.1) available after selecting the Patient's data command (menu File). The window 

opens a set of fields where one should enter information according to the labels next to each 

field.   

 

10.3. Dialogue window: Patient's data. 

10.2. Modification 

The patient's data modification can be done only before the examination beginning. 

After the examination beginning, the modification of the incorrectly entered and accepted 

data requires shutting down of this examination and launching a new one. One should then 

enter the correct data in accordance with the procedure of entering a new patient ( 

Chapter 10.1). The dialogue window: Patient's data includes patient's data from the last 

opened examination in the programme (regardless of the fact whether the examination was 

opened from the file or it was a new examination).   
The patient's data modification before the beginning of the examination can be done 

by means of the dialogue window: Patient's data ( 4.1. ) selecting the Patient's data 

command (menu File). The data modification is possible only after its previous entering ( 

Chapter 10). All patient's data can be modified.  
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10.3. Data survey 

The patient's data survey, that is the survey of its content on the day of performance 

of the open examination, is conducted after selecting the Patient's data command (menu 

File). Before the examination starts, it is possible to modify this data ( Chapter 10.2), and 

after its start or reading the examination from the file, it can only be surveyed.    
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11. Program options 

Programme options include information necessary for the proper conduction of the 

examination. They refer to the parameters of data transfer between the ergospirometer and 

the computer, and to the examination parameters. The examination options are available in 

the menu Tools.  

11.1. Environment conditions 

Upon selecting the Environment conditions command, there appears a dialogue window 

referring to the external conditions during the examination ( pic. 5.1.). 

 

11.4. Atmospheric conditions 

Not giving or giving the wrong parameter values about the temperature, humidity 

and pressure may lead to the distortion of the examination results. Those values can be 

entered manually reading them from the external appliances (thermometer, barometer, 

hygrometer) or by means of automatic reading. In order to do this, one needs to connect to 

the computer a special add-on device for reading the weather conditions, and then (after 

launching the Start 2000 programme) mark the field Turn on in the Automatic reading 

group. A Series port COM window w pic. 5.1. become activated where one should select 

the number of port to which the add-on device has been connected. By clicking the Read 

now button, the reading of the current atmospheric conditions will be made and the values 

will be entered into the dialogue window. This data can be updated both before and after the 

selection of the examination type. It is valid for 4 hours. It means that for 4 hours from 

entering the data the programme will not require the weather conditions update, regardless 

of the fact whether the programme was launched once or several times during this period of 

time.  
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11.2. Calibration 

After the selection of the Calibration command one needs also determine whether 

the calibration refers to gas or to volume. If the programme is launched without current 

atmospheric conditions, there will appear a dialogue window for their updating ( Chapter 

11.1). One should enter the current values of temperature, pressure and humidity or select 

the automatic reading of those values (if we have at our disposal the add-on device for the 

automatic reading of those conditions). Gas and volume calibration is valid for 24 hours. 

Calibration should be made in the ATP conditions.   

11.2.1. Volume calibration 

After selecting the Volume calibration command from the submenu Calibration in the 

menu Tools and possible updating of the current atmospheric conditions (if there appears a 

dialogue window referring to this), there will appear a dialogue window as shown in 

pic.5.2. 

 

11.5. Volume calibration. 

In the Calibration manoeuvre group in the Number field one should enter the number of 

correct movements of the calibration pump piston which finish the calibration. In the 

Irregularity field we enter the irregularity percentage of the pomp piston movement. 

Exceeding it causes that the programme rejects the manoeuvre whose irregularity 

exceeded the set percentage. This percentage is calculated from the average volume of 

all previous movements. Therefore, it is possible to reject the manoeuvre that was 

previously accepted. In the Calibration pump group in the Capacity field we give the 

volume of the used calibration pump. Before one starts calibration, one obviously has to 

connect the calibration pump to the spirometric head which is properly attached to the 

air cable connector. . Take a notice, that headpiece has two tips: wider and thinner. The 

wider one must be placed towards the pump. Also the connector has two holes: wider 

and thinner. They correspond to the tips of the headpiece. 
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5.2a. Plugging the headpiece to the air-tube connection 

 

 

 

 

 

 

 

 

 

5.2b. Headpiece connected to the air-tube 

 

Calibration is started by clicking the Start button and there is a steady movement of the 

calibration pump piston. In the Calibration factor field there is displayed the last correct 

calibration factor, and in the Number of steady manoeuvres field there is the number of 

movements accepted by the programme. In the Manoeuvre volume window there are 

displayed columns whose height indicates the volume of the performed manoeuvre. The 

number of columns corresponds to the number displayed in the Number of steady 

manoeuvres field. At the bottom of the window there is a field where the 'prompting 

messages' are displayed which facilitate the process of calibration. When in this field 

appears information that the calibration has been completed successfully, the process of 

volume calibration is finished. 
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11.2.2. Gas calibration. 

The dialogue window for gas calibration pic. 5.3.  will appear after selecting the Gases 

command from the submenu Calibration in the menu Tools.  

 

11.6. Gas calibration. 

This calibration may be summarised in the following points to be performed in a strictly 

determined order: 

In the Sample gas parameters group one should enter the O2 and CO2 concentration 

percentage in the sample gas (description on the calibration gas cylinder). Changes can 

be made only after connecting a new sample gas cylinder.  
After clicking the Start button there appears information that 'zero' will be read from the 

atmosphere. One should make sure that the end of the silicone gas cable (by the head 

connector) is 'let out' to the atmosphere. Then we confirm this with the OK button.  
For the next 30 seconds 'zero' will be read from the atmosphere. In the meanwhile, you may 

prepare the bag with calibration gas: 
 

- Squeeze the bag to remove an atmospheric weather from the inside (see the photo 

below) 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

5.3a. Sqeezing the calibration bag 
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- connect the bag to the bottle, and gently open the valve. Fill the bag with small 

amount of the gas (see photo below) 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

5.3b. Filling the calibration bag with gas 
 

- squeeze the bag again 

- fill the bag with a gas (more than previous) but not as much as a “balloon” 
 

After reading 'zero', the program will inform that the sample gas calibration will be 

conducted. Then one needs to connect the bag with calibration gas (if it is not already 

connected) to the end of the silicone gas cable (by the head connector).  
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

5.3c. Connecting the calibration bag to the air-tube 
 

Let the device vacuum the gas from the bag. Do not squeeze a bag or silicone tube. 
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The connection is confirmed with the OK button. The proper calibration process lasts also 

around 30 seconds. During the process the following information are displayed in the 

window: 
In the Currently read concentration group there are displayed the currently read 

concentrations of the proper gases. 
In the O2 – cylinder reading and CO2 – cylinder reading columns are drawn whose height 

corresponds to the values from the Currently read concentration windows.  
At the bottom there is a field where the 'prompting messages' are displayed that facilitate 

the process of calibration. When in this field appears information that the calibration has 

been completed successfully, the process of gas calibration is finished.  
In the Calibration Factors field the calculated calibration factors are displayed.  

5.3 Equipment configuration. 

After selecting the Equipment configuration command from the Tools menu, there 

appears a dialogue window with three pages. The first one, Ergometer, concerns the 

examination options related to the ergometer; the second one, Communication, includes the 

parameters related to the ergometer communication and other devices with the computer; 

the third one, General, determines the directory path for saving the examinations and the 

manner of power calculation on the basis of slope and speed of the moving track. All 

parameters set in here are saved in the programme. It means that after closing and opening 

the programme again the previously set parameter values will be still valid.  

11.2.3. Ergometer. 

The Ergometr page is presented in pic. 5.4.. 

 

11.7. Ergometer dialogue window. 
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In this window we determine the type of ergometer we work with during the examination. 

In one moment there may be only one or none of the fields marked. Marking any of them 

causes blocking all the others. By de-marking the field, we have the possibility of marking 

any field. Available fields are: Tapped control, MES control and No ergometer. By marking 

the Tapped control field and selecting the tapped device type we select the option of 

downloading the current load to the programme by reading it off the ergometer. The MES 

control field is dedicated for the selection of ergometer which we intend to control during 

the examination. Using this option one needs to set the examination phases before its start. 

In the No ergometer field we determine whether (if there is no ergometer) the phases should 

be set before or after the examination. If we decide that the phases should be set before the 

examination, the programme will not allow starting the examination when there are no 

phases designed and will remind us of this. If we select the option of setting the phases after 

the examination, upon finishing the examination there will automatically appear a dialogue 

window about the examination phases. If we do not mark any of the fields, we select the 

examination type which does not require any ergometer and we do not have to give the 

load. During such examination the load value in the WATT column will amount to '0'.   
The Type of load with no ergometer type selected field is dedicated to determine 

what type of load we are dealing with if there is no ergometer type selected. This 

information is necessary to calculate the VO2 norm.   
 

11.2.4. Communication. 

The Communication page is presented in pic. 5.5.. 
 

 

11.8. Communication dialogue window. 



Operating manual for Start 2000M ergospirometer 

 25 

In this window we determine the port numbers to which the tapped ergometer and 

control ergometer are connected. If there is no communication with any of these devices, 

one should check first of all whether the set numbers correspond to reality. While closing 

the window we confirm all the changes with the OK button. In the HR Source field we 

determine the type of device from which we read the HR value. If we choose Pulsoxymeter 

at the examination start, the OksyTest 1000 programme is launched which transmits the HR 

value to the programme. Similarly, if we select the Polar and Cardiax options, the Polar 

and CRX with Cardiax programmes will be launched respectively. Additionally, the 

selection of the Cardiax option is necessary if we want to read other cardiographic 

parameters. The detailed description of the cooperation with Cardiax can be found in 

Chapter 12.12. If during the test we use the Monark 829 bicycle as an ergometer, we have a 

choice of HR signal from the bicycle. Up to the 1.6.0.0 version the HR from bicycle or 

moving track was read only after the control phase. From the 1.6.0.0 version this parameter 

is read also during the control phase. The necessary condition for reading the HR parameter 

from the bicycle or moving track is the choice of the proper source in the menu and the 

choice of controlled ergometer in the Ergometer tab for the right bicycle or running 

machines (which transmit the HR parameter, e.g. Monark 829, 839, h/p/cosmos). 

11.2.5. General. 

The page General is presented in pic. 5.6.. 
 

 

11.9. The General dialogue window. 

On this page in the Directory with saved examinations field we give the access path 

to the directory where we wish to save the examinations. This path may be entered 

manually or created automatically. Automatic path creation occurs in two cases. The first 

one is when the default path is set. We do this by clicking on the Default button. Default 
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path is: c:\mes\Wyniki badań\ (c:\mes\Examination results\). In the second case the path is 

created in the directory selected in the dialogue window that appears after the Browse 

button. This window is presented in 5.7. 

 

11.10. Dialogue window: Browsing in search of the directory. 

After marking the selected directory and confirming this with the OK button, in the editing 

window there is displayed the path to the selected directory.  
In the Manner of power calculation for the moving track field we determine which 

formula to use in order to calculate the power on the basis of the moving track's speed and 

slope. It is used in the examination with the controlled ergometer if it is a moving track. We 

have the following formulae to choose from: 
 JAEGER: 
 

 for running:  
W [Watt] = (V * BW * (2.11 + G * 0.25) + 2.2 * BW - 151) / 10.5 

 for walking: 
W [Watt]= (V * BW * (2.05 + G * 0.29) + 0.6 * BW - 151) / 10.5 

 

 ATS: 

G = 100 * tan   

W [Watt] =  BW * V * sin  * 100 / 36.4 
 

 BRUCE: 

tan   sin      for small   
W [Watt] = BW * V * G / 36 

 

Abbreviations used in the above formulae stand for: 
BW –  patient's body weight [kg] 
V    –  moving track's velocity [km / h] 
G    –  slope [%] 
W   –  load [Watt] 
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 When we mark the Read SpO2 field upon starting the examination, the OksyTest 

1000 programme is launched which transmits the parameter value to the programme. The 

suitable module is necessary for this purpose.  
The System with three-way valve field should be marked if the three-way valve is used in 

the examination.  
 

11.3. Examination option. 

11.3.1. Document layout. 

The Document layout page is presented in pic. 5.8. 
 

 

11.11. Dialogue window: Document layout. 

In the Window layout in the view group we determine the number of all views in the part 

dedicated to diagrams ( Chapter 9). The minimum number is one, maximum – four. How 

many of those views will be the on-line type views is determined in Number of On-Line 

Diagrams. In the Height percentage for the table field we determine the percentage of the 

whole window interface to be covered by the table. The Scroll range for diagrams 

determines the period of time in seconds that will be visible on views with the scroll turned 

on. If we mark the Include the due in Table field, in the table of  the values of parameters 

which are due, they will be displayed in the colour dependent on the value and due relation. 

If the parameter value ranges between the minimal and maximal due value, then the cell has 

the sea-green colour. Sample fragment of the table including the dues is presented in pic. 

5.8. 
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11.12. Table including dues. 

11.3.2. General. 

The General with Examination Options page is presented in pic. 5.10.. 
 

 

11.13. Dialogue window: General with Examination Options. 
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With the Read spirometric parameters at start field marked, at the examination start 

the programme tries to read the patient's spirometric parameters. If there are any, they will 

be read and the parameter creation date will be checked. If they were created more than a 

month before, the user will be informed which parameters are concerned and when they 

were created. If there are no spirometric parameters of the patient, the user will also be 

informed about it.  
If the Indirect calorimetry field is marked, the energy consumption will be 

calculated with the indirect calorimetry method, otherwise the calorimetry will be 

calculated from the minute ventilation.  
Marking the Calculate calorimetry option enables to calculate the energy 

consumption during the examination. If this option is de-marked, the consumption will not 

be calculated despite the occurrence of examination conditions for the calculation.  
The Display the cause of test ending dialogue after examination option causes that 

after the examination there will be automatically displayed a window where we can give the 

cause of ending the test.  
Marked Show SBP/ DBP/ Borg/ Lct window with phase change introduces the 

automatic display of dialogue dedicated for entering the values of these parameters for 

examination. The window can also be opened with the SBP, DBP, Borg, Lct Entry 

command from the Tools menu or with the use of this icon: . 
 

11.4. User and Service. 

The User command produces a dialogue window with queries about the User's 

Login and Password (Błąd! Nie można odnaleźć źródła odwołania.).   
 

 

11.14. The User dialogue window. 

After entering the right key words, the User has access to certain options of the programme 

which are normally unavailable. It is used by the programme's service men.  
 The Service order is available for an average user. It is also used by the programme's 

service men.  
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12. Conducted examination options. 

12.1. Examination stages. 

Every examination consists of two stages: control stage and examination stage. 

During the control stage there are actions performed to prepare the ergospirometer for work. 

It includes resetting its memory and ventilation of the measurement system. When those 

actions are completed, the programme enters the analysis state in the control stage whose 

values are not saved. One should then check if the programme operates properly and if the 

parameter rows are added to the bottom table. During the examination stage we perform the 

proper examination which is divided into three parts: reference (resting), exertion and rest 

(restitution). During both stages the successive parameter values appear both on the diagram 

and in the table at time intervals determined with the Averaging parameter (Examination 

options -> Document view – Chapter 12.6). 
 

NOTE !!! 
1). The control stage is crucial for the correct performance and receiving reliable results in 

the proper examination stage, because in this stage the processes of ventilation and resetting 

the measurement system are conducted. During this process the pneumotachographic head 

connection cable must be as far as possible from the mouths of the patient and the operating 

personnel, because the great sensitivity of measuring systems of ventilation and exhalation 

gas concentration may lead to reading and saving the false zero of the module of ventilation 

and CO2/O2 gas analysers.  
2). In the control phase of the stage when the programme launches the analysis system, the 

three-way air connection cable must be connected to the pneumotachographic head installed 

to the measurement mask previously put on by the patient. The third cable of the three-way 

air cable, marked in blue, must be connected to the connection terminal installed in the 

mask connector.  
 

12.2. Examination phases. 

The dialogue window referring to the examination phases is produced by the Examination 

phases command from the Examination menu. This command is available only for the open 

document (new examination or examination opened from the file). This window is 

presented in pic.6.1.  
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12.15. Examination phases. 

Examination phases include information about the test parameters for the whole 

time of examination. The information are: phase name, its duration, load received by the 

patient, and speed and slope of the moving track (if it is used for the examination). The 

examination may consist in any number of phases.  
The window basically consists of three parts. The first one includes the list of all 

phases and their parameters. The second part includes fields to enter the data. The third part 

includes buttons used to edit the phases. While entering a new phase, one needs to 

determine both the X and Y parameters. The phase name is set by default as Phase no. x 

where x stands for the successive number of phase. But this name may be changed to any 

name. The X parameter is the phase duration time. In the Y parameter field we may enter 

the load, or the speed and slope of moving track during the given phase. Which field is 

active depends on the settings in Examination options on the Ergometer page ( Chapter 

11.2.3). If we select the option of tapped ergometer, none of the fields will be active 

because the load is read from the ergometer. The same situation takes places if no field is 

marked. If the examination uses the ergometer control, then in case of a bicycle the active 

field will be Load and in case of a moving track the active fields will be Speed  and Slope. 

By marking the Phases with no ergometer field one may enter the Load. If one enters to the 

phases the speed and slope of the moving track, then in the Calculated load there is 

displayed load calculated according to the formula set in Examination options on the 

General page ( Chapter 11.2.5). The load is entered to the phase while adding the phase.  
The Add button is dedicated to enter the set phase. Delete deletes the phase marked 

in the phase list. We mark it by clicking the left mouse button on the name of the selected 

phase. Delete all deletes all phases from the list. Change allows us to change the selected 

phase's parameters. The Save button saves the set of phases from the list in a file of the 

given name. The standard file extension is *.phs. The Read button is dedicated to load the 

phases from the file. In order to confirm the entered data we use the OK button. During the 

programme installation on the computer in the C:/Mes/Phases directory the files with the 

most popular examination programmes are saved. They are: 

1) Weber; 

2) Repty; 

3) Naughton Modified; 

4) Cornell; 

5) Bruce Modified; 

6) Bruce; 
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7) Acip Modified; 

8) Acip; 
The programme often requires for examinations setting the phases before the 

examination starts. This requirement concerns examinations using controlled ergometer and 

in case of the selection of the Phases set before examination option from the Phases with no 

ergometer field (Examination options -> Ergometer – Chapter 11.2.3). When we choose the 

Phases set after examination option, the programme will require entering the examination 

phases right after the examination ends and automatically display the window related to 

examination phases.   
The Load real phases button is dedicated to loading the real phases created 

automatically during the examination on the moving track. After pressing, the button name 

changes into Load project phases. It is dedicated to loading the project phases. If there are 

no real phases in the examination, then the phase field will be empty. While saving the 

examination, both real and project phases are saved.  
Marking the Auto Stop option causes the automatic ending of the examination when 

all the project phases are completed.      

12.3. Events. 

An event is a blue vertical line which marks the examination characteristic moment. 

The event is entered with the Enter event command from the Examination menu. The 

relevant dialogue window is presented in pic. 6.2.. 
 

 

12.16. . Event dialogue window. 

The event is entered when the examination is conducted. In the Name field one should enter 

the name of the event, and in the Commentary field – the description of the situation that 

occurred. In the time field there is displayed the moment of examination when the event 

was entered. We confirm this entry withe the OK button. The dialogue window presented in 

pic. 6.3. is used for event editing. 
 



Operating manual for Start 2000M ergospirometer 

 33 

 

12.17. Event editor dialogue window. 

It is possible there to change and delete events entered during the examination. The editing 

concerns the event marked on the event list (top dialogue window). Marking and de-

marking is done with the left mouse button. The OK button is used for confimation. From 

the 1.5.0.0 programme version the events are displayed also on the on-line diagrams.   
An event may also be entered after the examination. If we have a row marked in the 

table, then after giving the Enter Event command the above dialogue will be displayed with 

the set time from the marked row. Additionally, oen may enter the event from the Event 

editor dialogue and from the diagram menu.   
 

12.4. Remote control to the ergometer. 

This remote control enables us to control the ergometer. The remote control is 

presented in pic. 6.4. 
 

 

12.18. Remote control to the ergometer. 

We may control it manually or with the help of phases. If we control the ergometer with the 

help of phases, it is possible to skip one phase and move to the next one. We do this by 

clicking the Next phase button. If we move beyond the last phase, the controlled device is 
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stopped. The Last button id dedicated to moving to the beginning of the last phase. In order 

to lengthen the duration time of the currently operated phase, one should use the Hold 

button. Moving to the next phases will be blocked then until the button is released. During 

the blocking the button changes its name to Release. Unblocking the phase moves us to the 

phase that is after the blocked one. If we select manual control, there is a possibility of 

changing the speed and slope. There are buttons that change these parameters by the value 

displayed on the given button. The parameters cannot be reduced to the value below zero. 

Additionally, the manual control offers the possibility of stopping the moving track. In 

order to do this, press the Stop button. After that the button name changes into Start. 

Another click causes the start of the moving track with the last set values of speed and 

slope. The button name changes again into Stop. At the bottom part of the remote control 

there are fields that have the current values of speed and slope. When the moving track is is 

stopped with the Stop button, they include the last set values. When the control is changed 

from manual to phase control, the values of speed and slope are changed to those that are 

set for the phase conducted during at the time of change. In case of manual control the time 

determining the phase to be conducted is constantly running. If we go back to control with 

the help of phases, there will be activated the phase that corresponds to the change time. If 

the last phase is completed, the moving track is stopped. If the control is changed from 

automatic to manual, the current values of speed and slope are the last values set by phases.   

12.5. Diagram view. 

The programme offers two types of diagram views. They are views of parameter 

diagrams and the course on-line views. Sample diagram view is presented in pic. 6.5.  
 

 

12.19. Diagram view. 

The sample view includes the diagrams of four parameters. It presents the maximum 

number of parameters in one view. Which parameters should be displayed in the view is set 

in the reference menu in the diagram view ( Chapter 12.5.1). Every diagram is drawn in 

another colour. Which Y axis corresponds to which diagram is determined by the Y axis 

colour. Similarly, the diagram in a given colour is the diagrma of the parameter whose name 

is displayed in the same colour as the diagram. In case of on-line views the X axis is the 

time axis and is common for all diagrams. In the parameter diagram the X axis parameter 

may be any parameter. Additionally, the active diagram is marked with a blue frame at the 

top and right side of the view. It will affected by the commands of stretching/ narrowing the 

scale of the vertical and horizontal axis and synchronisation of the table and other 

parameters. The diagram is activated by clicking on the selected diagram with the left 

mouse button.       
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12.5.1. Reference menu of the diagram view. 

One may set here options referring to the diagram display in the given view. It 

appears after clicking with the right mouse button on the selected view. The menu is 

presented in pic 6.6. 
 

 

12.20. Diagram view options menu 

12.5.1.1. Show events. 

Marking the Show events field (so-called 'tick') means that this option is activated. It 

displays the events entered during the examination ( Chapter 12.3). Marking and de-

marking this option is done by selecting this command.  

12.5.1.2. Parameters. 

In order to determine which parameters should be displayed in a given view, one 

should select the Parameters command from the menu in pic. 6.7. There will appear a 

window as presented in pic. 6.7. If the selected view is of the on-line type, then the window 

will have different parameter list.  
 

 

12.21. Dialogue window for selecting the parameters for the diagram view. 

One may select the maximum of four parameters for each view. If we try to select more 

than four parameters, the programme informs about exceeding the allowed number and does 
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not allow marking another one. In order to mark another parameter, one should de-mark one 

of the already marked parameters. The parameters are marked and de-marked by clicking 

on the selected parameter with the left mouse butoon (in the field on the left of the 

parameter name). The Min. number button is dedicated to mark the minimal number of 

parameters (one parameter). De-marking is also done from the top of the list until only the 

minimal number of parameters is marked. The selection of parameters is confirmed with the 

OK button. 

12.5.1.3. Predicted values. 

Marking this option causes that in the given view there are displayed due values of 

the parameters. There are displayed due values of parameters that have such due values. 

Due values take the shape of two lines which mark their bottom and top limit. Those lines 

are drawn in the same colour as the parameter diagram. Displaying the dues concerns both 

the Y and X axis parameters. The sample view with the due values is presented in pic. 6.8. 
 

 

12.22. View with marked due values and anaerobic threshold. 

12.5.1.4. Type of diagram. 

This command allows us to choose between the line and point diagram type in the 

given view. 

12.5.1.5. Print the diagram. 

 Selecting this command results in printing the given diagram view.  

12.5.1.6. Enter AT threshold. 

It consists in manual placing the indicator (Chapter 12.5.1.9) in the place where we 

think that the anaerobic threshold is. In the selection field there appears an orange vertical 

line that marks this threshold. The programme looks for the breath that is closest to this 

place during the load phase. In the table the anaerobic threshold is marked with larger bold 
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and underlined font (only in case of averaging by breath). This option is available only if 

the examination is completed and the number of phases in the examination is bigger than 

one.  

12.5.1.7. Show AT threshold. 

It results in displaying in the given view the anaerobic threshold (if it has been 

determined). The view with the threshold displayed is presented in pic. 6.8. 

12.5.1.8. Background colour. 

This option allows us to change the background colour of the given diagram. 

12.5.1.9. Indicator. 

Marking this option results in displaying on the diagram a thin vertical line that is 

the indicator. It is used to select the place where we would like to place the Event or the 

anaerobic threshold. While surveying the diagram content with the indicator  in the 

programme status line we receive information on the phase conditions of the examination 

(which phase was conducted, how much time was left to its completion, how much time 

was left to the examination completion). Obviously, information about the phases if 

displayed only if there are any phases in the examination. The information refers to the real 

phases.   

12.5.1.10. Enter event. 

This command results in entering the Event into the examination in the place where there 

currently is the indicator.  

12.5.2. Diagram options. 

12.5.2.1. Change of axis scale. 

In order to change the axis scale use the command from the View menu: Streching the X 

scale, Narrowing the X scale, Stretching the Y scale, Narrowing the Y scale. Thos 

commands are repeated in the toolbar buttons with the (+/-) magnifiers with the right scale 

marked . Stretching the Y scale is possible for all the diagrams, while 

stretching the X scale is possible only for the diagrams with Scroll (on-line diagrams and 

parameter diagrams with activated Scroll). Those operations affect the active diagram. The 

smallest possible X axis scale is restricted to 10 seconds.  
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12.5.2.2. Synchronisation of the table with the diagram. 

This command (View menu) is dedicated to set the table in the time place (its Scroll) in 

which the diagram is active. This option refers to diagrams with Scroll. The command is 

repeated in the toolbar . 
 

12.5.2.3. Synchronisation of diagrams with the diagram. 

This command (View menu) is dedicated to set the other diagrams with Scroll in the time 

place in which the diagram is active. This option refers to diagrams with Scroll. The 

command is repeated in the toolbar . 
 

12.5.2.4. Default X scale range. 

This command (View menu) is dedicated to setting in all diagrams with Scroll the same 

scroll range (set previously in the options – Chapter 11.3.1). The command is repeated in 

the toolbar . 
 

12.5.3. Table. 

Sample table is presented in pic. 6.9. 
 

 

12.23. Parameter table. 

The table presents the values of the selected parameters at the given moments of the 

examination. When the size of the table exceeds the available screen area, there appear 

scrolls with bars at the bottom and on the right which enable to display any fragment of the 

table. If we mark the Include dues in the Table field one the View page in Examination 
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options (Chapter 11.3.1) in the value table of parameters that have dues, they will be 

displayed in the colour depending on the value and due relation. If the parameter value lies 

within the range of minimal and maximal due value, then the cell will be sea-green (normal 

value). In other cases, it is white. If the HR parameter is incorrect, four horizontal dashes 

are displayed there. 

12.5.4. Table view options. 

Table view options are available in the context menu that appears after clicking on 

the table view with the right mouse button (pic. 6.10).  
 

 

12.24. Table view menu. 

If we mark the table row (with the left mouse button) while surveying the table content, we 

receive in the programme status line the information about the phase conditions of the 

examination (which phase was conducted, how much time was left to its completion, how 

much time was left to the examination completion). Obviously, this information is 

displayed if there are any phases in the examination. The information refers to the real 

phases.  

12.5.4.1. Parameters. 

The parameters displayed in the table are selected from the dialogue window which 

appears after choosing the Parameters displayed in the Table command from the View 

menu. The window can also be opened by clicking on the Parameters command in the table 

menu. The window is presented in pic. 6.11.  
 

 

12.25. Dialogue window for the selection of parameters in the table. 

In the window with the parameter names we select those that we would like to display in the 

table. Marking and de-marking is done by clicking on the selected parameter with the left 

mouse button (in the field on the left side of the name). One may switch the parameters' 
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place (they will be displayed in the table in this order). In order to do this we click on the 

selected parameter with the left mouse button and drag it to the desired position.  
The Max. number button is used to mark the maximal number of the available parameters 

(in the present version it is 20). Marking is completed from the top of the list until the 

maximal number of marked parameters is reached. The Min. number button is used to mark 

the minimal number of parameter (2 parameters). De-marking is also done from the top of 

the list until there is only the minimal number of parameters marked. The selection is 

confirmed with the OK button. Print results in printing the table with the printer. 
The parameters from which examination moments appear in the table is determined by the 

selected averaging ( Chapter 12.6).     
 

12.5.4.2. Remove / Restore. 

The programme offers the possibility of removing the rows from the table if we 

suspect that there was some interference. The remove and restore option is possible only if 

the rows are averaged by breath. In order to remove a given row, one needs to highlight it 

with the left mouse button and then select the Remove/ Restore command from the table 

menu. Then the highlighted row turns grey and the parameter values of this row change into 

the average value from the previous and next rows. On the printout the removed row is 

marked in bold italics. In order to restore the original row, we act in the same way as with 

removing (highlighting the removed row). While saving the examination, the original and 

removed rows are recorded, so it is possible to restore the original rows in the examination 

saved with removed rows. It is possible to remove or restore several rows at a time. One 

should highlight several rows with the use of the Shift key and the left mouse button and 

then select the Remove/ Restore button. Within the highlighted area the removed rows will 

be restored, and those that are not removed will be removed.    
 

12.5.4.3. Enter event. 

This command allows to enter an event in the time represented by the highlighted 

row. In order to do this, one needs to highlight the row in the table with the left mouse 

button and then select the Enter event command from the table menu. There will appear a 

dialogue window for entering the Event with the set time of the highlighted row.  

12.5.4.4. HR editing. 

This command allows to edit the HR parameter in the highlighted row. It is 

available only with averaging by breath. In order to edit the HR parameter, one need to 

highlight the row and select the HR editing command from the table menu. There will 

appear the dialogue window that contains the old parameter value. One should modify the 

value and confirm this with the OK button. (pic. 6.12). 
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12.26. HR editing dialogue window. 

12.5.4.5. Pop-Up window. 

It is the window where the given parameter is displayed during the examination. 

The parameter is displayed in a very large font, which enables the observation of its value 

from afar. We select the parameter by clicking the left mouse button on the window area 

which presents us with the parameter selection menu. We may select only one parameter 

(i.e. in order to mark the selected one, one should de-mark the one previously marked). It is 

not possible to select the time and ordinal number parameters. The command for displaying 

the Pop-Up window is available in the View menu and on the toolbar.  

 

12.27. Pop-Up window. 

12.5.4.6. Synchronisation of diagrams with the table. 

This command (available in the View menu) results in setting all the diagams with 

Scroll in the time place where the highlighted table row is. The table row is highlighted by 

clicking on it with the left mouse button. 

12.5.4.7. Table printout. 

By selecting the Print Table command from the View menu or pressing the Print 

button in the parameter dialogue window (Chapter 12.5.4.1) we print only the table with the 

printer.  

12.6. Averaging. 

If we select the Data averaging command from the View  menu there appears a 

window as presented in pic. 6.14. 
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12.28. Dialogue window: Averaging the results in the table. 

Here we select the averaging method the data read during the examination. The programme 

saves the data after the patient's each breath, so it is possible to change the averaging 

method for the examination opened from the file. If we select by breath method the 

parameter value will be the value for the given patient's breath. If we select any of the 

times, then the parameter value is the average of its values from the selected time period. 

With the change of the averaging method there also changes the number of samples that are 

displayed in the table and in the diagram, because their number depends on the period of 

time from which their average value is calculated (from by breath to every 5 min.). 

Therefore, the averaging method change changes the outlook of the displayed diagrams and 

tables. If we select the by phase method, the averaging will be made according to the 

periods of time of the individual phases. On the right we determine the phases according to 

which the averaging is made. If we select averaging according to the real phases and there 

are no real phases, the programme will notify about this fact and average the data according 

to the project data. If there are no phrases set, then the option of averaging according to 

phases is inactive.   
 

12.7. Zeroing the flow and gases. 

To operate properly the measurement systems have to be zeroed before every 

examination. Zeroing is conducted automatically in the starting moment of a new 

examination. It can also be launched from the menu with the Flow zeroing and Gas zeroing 

commands.  

12.8. Export to the statistical programmes. 

This command orders the programme to convert the open document into a text file 

with the format that enables its reading and processing in the Microsoft Excel spreadsheet. 

Since it is a text file, it can be even modified with the simplest word processor (e.g. 

Notepad from the Windows' Accessories). The converted file is saved in the directory from 

which the document was opened and has the *.txt extension. The file name is identical with 

the name of the examination that we want to convert. 
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12.9. Clearing the ergospirometer menory. 

Usualy the field test requires disconnecting the spirometr and the PC. Because of this, 

Start 2000M uses its internal memory. This memory stores the samples, collected by the 

spiromemter, since the PC is disconnected.  Before starting a new field test, you have to 

be sure that internal memory was cleared. It is executed automatically before each test, 

however it is possible to do it manually the command Clear Ergospirometer Memory 

from Test menu.      

12.10. Last parameters LT. 

This command is used to display the last spirometric parameters for the given 

patient (not the ones saved with the examination). If there are no parameters, the 

programme informs the user about this fact.  

12.11. Show predicted values. 

Selection of this position from the Tools  menu displays the available predicted 

values for the given patient. If there are no predicted values, the user is informed about this 

fact.  

12.12. ECG parameters. 

The programme enables reading the HR parameter during the examination. It is necessary 

to have the ECG signal source, e.g. Cardiax, POLAR or other device.  
The programme reads the HR parameter while operating if one of the sources is marked in 

the HR source group in the Communication tab in Examination options.   
 

 The ECG Cardiax system is an independent device (look: Cardiax manual), but it 

can also operate together with the ergospirometer.   

12.13. Predicted values. 

The programme calculates the predicted values for four parameters. They are: VO2, 

HR, MVMAX, BR. In order to cacultate the norm for the last two, the spirometric parameter 

MEF50 is necessary. One can obtain it from the spirometric examination (Chapter Błąd! 

Nie można odnaleźć źródła odwołania.). Those norms are calculated according to the 

Wasserman standards. Calculated values may be: 
a) displayed (Chapter 0) ; 
b) included in the diagram (Chapter 12.5.1.3); 
c) included in the table (Chapter 11.3.1) 
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12.14. Find the AT threshold. 

This command is located in the Tools menu (during the open examination). It is 

dedicated to automatically find the examination moment that is closest to the anaerobic 

threshold criterion. If such moment cannot be found in the examination, the programme 

informs the user about this fact.  
 

12.15. Remove the AT threshold. 

This command is located in the Tools menu (during the open examination with the 

AT threshold marked). It removes the previously marked or found threshold from the 

examination.   

12.16. Indirect calorimetry. BMR norm configuration. 

In order to calculate the energy consumption, one should mark the Calculate 

calorimetry option in the General tab in Examination options. The energy consumption 

determined during rest or exertion is calculated with two methods: direct or indirect. The 

direct calorimetry method is the most accurate and requires expensive instruments, 

therefore few institutes use it. The indirect calorimetry method consists in calculating the 

energy consumption with the help of the analysis of oxygen consumption during the 

exertion which should last minimum 5-6 minutes because in such a period of time the 

functional equilibrium is achieved. Total energy consumption consists of three elements: 

- basic metabolism necessary to provide basic living functions which depends on the 

body surface of the examined person and the non-fat body weight – 60 75 %; 

- specific dynamic food actions – 10  15 %; 

- energy consumption during motor activity related to everyday actions – 15  30 %. 
In order to conduct the BMR norm configuration, click on the BMR norm configuration 

command in the View menu. A dialogue window (pic. 6.15) will appear where one should 

mark the selected norm author: 
 

 

12.29. BMR norm configuration. 

Formulae for the BMR values: 
 

Harris Benedict: 
Men: [kcal/day] = 66 + 13.75 * weight + 5.0 * height – 6.76 * age 
Women: [kcal/day] = 65.5 + 9.56 * weight + 1.85 * height – 4.68 * age 
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Owen: 
Men: [kcal/day] = 879 + 10.2 * weight 
Women: [kcal/day] = 795 + 7.2 * weight 
 

Miffin: 
Men: [kcal/day] = 5 + 10 * weight + 6.25 * height – 5 * age 
Women: [kcal/day] = - 161 + 10 * weight + 6.25 * height – 5 * age 
 

where: 
weight [kg]; 
height [cm]; 
age [years].   
 

12.17. Calorimetry based on the minute ventilation. 

 

It is not always possible to determine the energy consumption on the operating place with 

the help of the classic indirect calorimetry method. In the practice of industrial examination 

there is often used a method based on the results of the lung ventilation measurement. There 

is a high correlation coefficient and almost linear relation between the oxygen consumption 

during exertion and the minute ventilation value. The approximate value of the energy 

consumption may be calculated with the use of Datta-Ramanathana equation: 
 

 

  REE(EE) = 0.21 x VE(STPD)  [kcal/min] 

 
 

where VE(STPD) – lung ventilation in L/min in the STPD conditions (volume of dry gas in 

the temperature of 0oC and the atmospheric pressure of 760 mmHg). 
In order to calculate the calorimetry with this method one should mark the Indirect 

calorimetry in Examination options -> General. In order to convert the value from one 

method to another, one needs to mark and de-mark the above-mentioned field and issue the 

Convert calorimetry command from the View menu.  

12.18. Commentary. 

To the examination we may add the commentary that would characterise it. In order to add 

commentary one should select the Commentary command from the Examination menu. 

There will appear a dialogue window to enter the commentary (pic. 6.16). 
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12.30. Window to enter commentary. 

The information entered should be confirmed with the OK button. The commentary is saved 

with the examination. In order to read the saved commentary, one needs to select the 

Commentary option from the Examination menu.   
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13. Conducting the examination. 

13.1. Preparation for work. 

1. Check if the ergospirometer is connected to RS 232 port in the computer. 
2. Check if the pneumotachographic head is properly connected to the device 

( Chapter 7). 
3. If the examination is conducted with the use of pulse sensor, be sure that 

POLAR receiver is connected to port K2( Chapter 1). 
Caution !! While connecting the receiver with Start2000M switched on, 

You have to restart it with main ON/OFF switch then. 
4. If the examination is conducted with the use of POLAR, connect it to the 

proper computer port ( Chapter 11.2.4). 
5. Connect the mouthpiece to the pneumotachographic head or the 

pneumotachographic to the mask . 
6. Launch the ergospirometer with the W1 mains switch( Chapter 1) 
7. Check if green diode- Status, lights( Chapter 1), it means the 

ergospirometer is ready to use 
8. Start the Start 2000M program. 
9. Set the programme options ( Chapter 5). 
10. Conduct the examination according to the description from Chapter 7.2. 

13.2. Conducting the examination. 

The necessary condition for the test start is checking if all the measurement elements of 

the device function properly. The check is possible thanks to the procedure of calibration of 

the gas analysers and the ventilation measurement system (Chapter 11.2). It is 

recommended to calibrate the device before conducting a series of examinations on a given 

day.  
During the examination the only command available is the one ending the examination 

(the Stop command from the Examination menu). It prevents all incorrect methods of 

ending the work with the programme (e.g. closing the programme during the examination).  
 

The whole examination may summarised in the following points:  
1. Control the device for safety from electric shock checking visually the condition of 

the electric cables.  
2. Perform the everyday device service according to the guideline from Chapter: 

Maintenance and everyday service. 
3. Turn the device on with the use of the mains switch at the back of the device (W1 

switch in pic.7.1. 
4. Leave the device on for at least 30 minutes so that the measurement elements would 

gain the thermal stability. Check if green diode- Status, lights( Chapter 1), it 

means the ergospirometer is ready to use 
5. Start the Start 2000M programme. 
6. Enter the patient's data ( Chapter 10). 
7. Match the proper size of the measurement mask for the patient so as to ensure the 

tightness on the contact point with the skin of the face.  
 

NOTE! 
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A/ It is recommended to connect the pneumotachographic head to the mask before 

putting it on; 
B/ One should remember not to connect the pneumotachographic head connection 

cable before the automatic zeroing procedure of the measurement system is 

completed; 
8. Set the examination options ( Chapter 11.2.2). 
9. Start the examination by clicking the L icon (Test in the laboratory  Chapter 

13.2.1) or the T icon(Test in the open air  Chapter 7.2.2). 
10. Conduct the examination according to the description of this type of examination.  
11. Finish the examination with the Stop button (button with the red circle). Save the 

examination ( Chapter 7.2.) 
12. In order to conduct another examination, one should close the open examination 

(the Close command in the File menu). Further procedure goes as described above 

starting from point 3. The patient's data refer to the last patient. When the 

examination is conducted on another patient, the data should be modified ( 

Chapter 10.2).  

13.2.1. The examination TEST without ECG, in the laboratory. 

This examination is started by clicking the L button or selecting the Test for Start 

2000 M command from the Examination menu. Obviously, one has to enter the patient's 

data first ( Chapter 10) and set the programme options ( Chapter 11). If the 

programme's calibration is invalid, it will require the calibration of gases and volumes. Such 

calibration is valid for 24 hours. The same is true for the environment conditions. The 

measurement system is ventilated automatically – 'Ventilation of the measurement system' 

presented with the help of progress bar. After the ventilation is finished, the system asks 

whether it should zero, then after pressing OK, there is the zeroing conducted – also 

presented with the help of progress bar.  
 

NOTE. 
a/The pneumotachographic head connection cable cannot be connected to the 

pneumotachographic head attached to the mask; 
b/It is required to move the pneumotachographic head connection cable as far away 

as possible from the mouth of the examined person or the person operating the 

ergospirometer!  
c/After the zeroing is completed, the measurement system is in the control phase 

and then the pneumotachographic head connection cable should be connected to the 

head and the connection terminal in the mask; 
If the last update took place more then 4 hours before the attempt to start the test, the 

programme will remind about the data update ( Chapter 11.1). When this type of 

examination is selected, the programme menu and toolbar changes. The toolbar is presented 

in pic. 7.1. 
 

 

13.31. Toolbar for the examination Test in the laboratory. 

The test is started wen the Start command from the Examination menu. Depending 

on the examination option settings, the programme goes to the control stage of the 

examination ( Chapter 12.1) or requires entering the examination phases ( Chapter 

12.2). After entering the phases, the examination should be started once again. If the 

programme operated correctly in the control stage, we may go to the examination stage by 
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clicking the GO icon or selecting the Start test command from the Examination menu. The 

control stage for the 1.6.0.0 version could last maximum of 5 minutes. From the 1.6.0.0 

version it is unrestricted, but every 5 minutes a reminder is displayed that we are in the 

control stage. In this time is exceeded, the programme informs about this fact and 

recommends starting the examination from the beginning. In the examination stage the 

diagram views and tables with parameters are zeroed. If the examination is conducted with 

the use of a controlled ergometer, the control is initiated. Ergometer control can be done on 

the basis of the examination project phases or with the help of remote control. The remote 

control is launched with the Ergometer control command from the Examination menu or by 

clicking on the remote control icon in the toolbar. Operating the remote control is described 

in Chapter 12.4. During the examination the ergospirometer pumps are working. Should the 

need arise they can be turned on and off with the Pumps On/ Off command (Examination 

menu) or with the pump button on the toolbar.  
 During the examination in the diagram views there are drawn the on-line courses 

and diagrams of parameters selected in the reference menu of the diagram view ( Chapter 

12.5.1.2). The values of individual parameters are entered to the table in Examination 

options -> Document view ( Chapter 11.3.1). One may also set there the number of 

diagram views. During the examination with the set phases and controlled ergometer, in the 

status line there is entered information about the number of all the phases, the number of the 

current phase and the time left to the phase completion, and the time left to the test 

completion. The examination is stopped with the Stop command from the Examination 

menu. One should then save the conducted examination to file ( Chapter 7.3.). The 

programme saves the diagrams and table columns for all parameters, irrespective of which 

and how many parameters we have selected to be drawn on the diagram and in the table. It 

means that after opening the examination from the file, we have access to all diagrams and 

values of all parameters from every moment of the examination. 

13.2.2. The examination TEST with ECG, in the laboratory. 

This examination is started by clicking the L button or selecting the Test for Start 

2000 M command from the Examination menu. Obviously, one has to enter the patient's 

data first ( Chapter 10) and set the programme options ( Chapter 11). If the 

programme's calibration is invalid, it will require the calibration of gases and volumes. Such 

calibration is valid for 24 hours. The same is true for the environment conditions. The 

measurement system is ventilated automatically – 'Ventilation of the measurement system' 

presented with the help of progress bar. After the ventilation is finished, the system asks 

whether it should zero, then after pressing OK, there is the zeroing conducted – also 

presented with the help of progress bar.  
NOTE. 
a/The pneumotachographic head connection cable cannot be connected to the 

pneumotachographic head attached to the mask; 
b/It is required to move the pneumotachographic head connection cable as far away 

as possible from the mouth of the examined person or the person operating the 

ergospirometer!  
c/After the zeroing is completed, the measurement system is in the control phase 

and then the pneumotachographic head connection cable should be connected to the 

head and the connection terminal in the mask; 
If the last update took place more then 4 hours before the attempt to start the test, the 

programme will remind about the data update ( Chapter 11.1). When this type of 

examination is selected, the programme menu and toolbar changes. The toolbar is presented 

in pic. 7.1. 
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13.2. Toolbar for the examination Test in the laboratory. 

 

After the patient’s data are entered, in the Examination menu, the command Test 

with ECG  and the icon with name ECG in the toolbar are activated. The test is initiated 

by selecting the Test with ECG or the icon ECG in the toolbar and after than the 

program „db2mdw.exe”, placed in the Start2000M software folder is activated and 

appears in the system’s container(right lower corner of the screen). The programme of 

ECG test „Welch Allyn Cardio Perfect” with patient’s data from the Start 2000 program 

is now started automatically. After all the command Test with ECG starts the program 

„WelchToErgo.exe”( uses for transmission beetwen ECG’s and ergospirometer’s 

softwares.)which is also placed in the Start’s 2000M catalogue. The programme starts in 

the minimalised version and therefore does not contain it’s own window (it is on the 

examination toolbar, but it is anvisible). In the Start2000M software the blocade against 

automatically starting of next „WelchToErgo”copy applies, if it is exists. Start of Test 

with ECG  changes the hardware configuration of Start 2000M for non- required 

entering the examination phases and selects a type of ergometers on the ground of 

information from Welch Allyn software(it secures against collision with ECG software), in 

accordance with requirements of ECG tests. 

The system is ready to start ergospirometry and ECG stress(the sequence is 

free), so we start both module but we don’t jump to the right steps(keeping in the 

control stage – in the Start2000M don’t press GO, and in the „Welch Allyn Cardio 

Perfect” don’t press Start).The ECG test is the superior. We control both systems and if 

everything goes properly and correctly, press the button Start in the ECG).The right 

stage in the ECG module is activated and simultaneously the button GO in the 

Start2000M is selected automatically. Test Start2000M goes, and through the 

„WelchToErgo.exe”, receives informations about name of a load stages program in 

ECG test, applied ergometer type’s, (bicycle or treadmill) and  about all changes during 

ECG test (especially load’s, speed’s and elevation’s changes). On the base those 

informations Start2000M creates own stages, which are the copy of load stages used in 

the ECG module. In the ergospirometry there are visibled as real stages.If you stop ECG 

test, automatically and simultaneously stops ergospirometry also and closes the 

„WelchToErgo” programme. The „WelchToErgo” programme closes also if the 

ergospirometry is manualy stoped. Programs „db2mdw.exe” and „WelchToErgo” are 

placed in the Start’s 2000M catalogue during instalation of the ergospirometry software. 

 

 

Important!!! 

 

It is neccessary to change the set up in the Cardio Control”, after instalation, in 

order to reach correct collaboration with the Start 2000M programme.To this effect, go 

to menu Plik -> Set up. and than chose the EKG icon, Monitor fold. Mark option „ Use 

event dispatcher for to the external applications”, in the lower part of window’s. 

Confirm using button Apply or Yes and close the window. 
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13.2.3. The test in the open air 

This test does not utilize any ergometer. The test is initiated by selecting the Test 

in the open air command from the Examination menu, or by clicking the icon with letter 

T. The toolbar of the software will then change its appearance, as shown in Fig. 32. 

 

 

13.32. Toolbar of the Field Test function Test in the open air 

Before initiating the test, the device checks if there are any free records available 

in the memory. If there is one, the test results will be written in that record, and if there 

is no record available, the system will recommend the clearing of the Flash memory of 

the device; in addition, it will inform on the number of tests recorded in the device, and 

it will allow the user to leave the active software level and to store the tests results 

recorded in the device. 

 

The checking stage of the test procedure ( Section 6.1) starts when the Start 

command is selected from the Examination menu, but this is preceded by the ventilation 

routine and by resetting the measurement system ( Section 7.2.1). This test procedure 

does not require setting up test phases. When the checking stage is completed and it is 

confirmed that all the parameters are measured correctly, the actual test procedure can 

be started. This can be done by selecting the Test start command from the Examination 

menu. As this can be a field test (as the name of the function says), and it can be 

conducted without continuous connection between the ergospirometer and the 

computer, the ergospirometer can be disconnected from the computer without 

interrupting the test. To disconnect the device, select the Disconnect ergospirometer 

command from the Examination menu. The device can be then disconnected physically 

from the computer and the patient can be requested to perform the planned exercise test 

(for example, a running test) with the ergospirometer on. On disconnection, the device 

stores all test data in its internal memory. Once the test is completed, the ergospirometer 

must be reconnected to the computer (the computer remains in test mode while the 

ergospirometer is disconnected). After reconnecting the device to the computer it is 

necessary to retrieve the data from the ergospirometer memory. This can be achieved 

with the Connect ergospirometer command from the Examination menu. The duration 

of the data transfer depends on the test duration, and may take up to three minutes. The 

test is terminated by means of the Stop command from the Examination menu. While 

the ergospirometer is disconnected from the computer, the latter may be switched off. 

After disconnecting the device, the test should be terminated. The software will then 

record the test data in a format that allows the same test to be automatically opened 

when the software is started next time. Data from the ergospirometer can be then read 

out (see above). After completing the test, it should be saved ( Section 7.3.). The 

software saves plots and columns of the table with all parameters, regardless of how 

many and which parameters have been selected to be plotted and to be shown in the 

table. This means that when the test is opened from file, all plots are accessible and all 

parameter values representing each moment of the test are available as well. 

13.2.3.1. Radio terminal (optional) 

Field tests can be observed in real time on the computer screen from a distance 

up to 1000 metres using the optional radio terminal. 
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The radio terminal (stationary part) should be connected to the PC by means of 

the START 2000M connecting cable. The terminal (its stationary part) is powered with 

two AA-size rechargeable batteries that can be recharged in the external charger 

supplied with the terminal. 

  The radio terminal (mobile part) should be connected to the START 2000M 

module using a special connecting cable. This part is powered from the START 2000M 

module. 

 

Indicators of terminal status: 

Red LED Yellow LED Modem status 

Continuous Continuous Modem test 

On Off Low battery voltage (refers to the module at the PC) 

Blinking Off Establishing the transmission / setting up data frame / 

transmission errors 

Off Blinking Data package transfer in progress 

 

NOTE! 
 The START 2000M module cannot be started in the LUNGTEST 1000 mode 

through the radio link. Also, it is not recommended to perform volume and gas analyzer 

calibration, and also recorded test data readout through the radio link. 

13.2.3.2. START 2000M Terminal (optional) 

Conducting a field test in the standard manner may be very inconvenient for the 

operator and detrimental for the portable computer controlling the START 2000M 

measuring module. Tests in the mountains and, especially, in coal mines (heavy 

pollution), with standard records of the last test data opened from a portable computer, 

significantly limits the possibility of performing one test immediately after another. It 

should be remembered that ambient conditions during field tests change and each 

subsequent test is performed in completely different ATP conditions. MES has 

developed and implemented a small, lightweight, dust-proof terminal which can replace 

the computer in the field, and is able to start up to 20 tests (also for different patients) 

and to update the values of ambient pressure, temperature, and air humidity. 

Calibration of the device is done using the standard procedure, from the 

computer ( Section 5.2. - Calibration). Each start of a new test is preceded by an 

update of the ATP conditions, which is done from the START 2000M terminal. Each 

new test with the use of the terminal is started by selecting the Test from the Ergo unit 

command from the Examination menu, or by clicking the icon with letter G. The toolbar 

of the software will change to the one corresponding to the field test (Test in the open 

air Terenie). This is shown in Fig. 32. 

13.2.3.2.1. Connecting the terminal to the START 2000M module 

The terminal is connected to the socket marked “PC” of the START 2000M 

module by means of the cable supplied with the terminal. If the terminal is working 

properly after it has been connected, a message saying “START 2000M” is displayed.  

The terminal is powered from the START 2000M ergospirometer and is connected with 

it only through a single cable plugged into the “PC” socket (the same socket is used to 

connect the PC). The connection ensures easy operation of the terminal. The built-in 

LCD display and keypad ensure communication with the START 2000M 

ergospirometer. The terminal must be able to initiate the whole process related to ATP 
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parameters reading and checking procedure (including ventilation and zero setting the 

measurement module), showing the measured ventilation values, O2/CO2 

concentration, and pulse rate on the LCD display. Starting a test from the terminal must 

be equivalent to the same done from the computer and cannot produce any errors. 

13.2.3.2.2. Reading and storing ambient conditions 

 

All sensors necessary to measure ambient conditions are incorporated into the 

terminal, therefore correct measurements of these values must be performed with the 

terminal left alone (not warmed up nor dampened by hands touching it). If the terminal 

has been warmed up or dampened, it must be laid aside for a while until its temperature 

and humidity equalizes with the environment. Current ambient conditions can be read 

out after pressing the “5” key. The message “Actually ambient conditions.” will appear 

and then the measured values of ambient pressure, temperature and humidity will be 

displayed. These values will be stored in the terminal. To perform a test, these stored 

ambient conditions data must be transmitted to the START 2000M module. This can be 

done by pressing the “6” key. The values stored in the terminal will be then displayed, 

followed by the “Save?” question. Accepting the proposal by pressing the “←” key will 

program the START 200M module. In case when the values are incorrect, the 

programming can be cancelled by pressing the “7” key.  

 

13.2.3.2.3. Recording a test 

 

The function of test recording is invoked by pressing the “9” key. The terminal 

will then display the “Test?” message. Accepting it by pressing the “→ “ key will 

initiate the test and invoke the resetting of the measurement system (gas analyzer and 

spirometer). The invoked function can be cancelled by pressing the “7” key. 

 

During the resetting procedure (indicated by the “Zeroing” message), the mouthpiece 

and air duct must be disconnected from the mask! 
 

When the resetting is finished and the “Recording start” message is displayed, the 

mouthpiece and gas duct can be connected to the mask. The START 2000M module is 

then in measurement mode, and this can be confirmed by observing the reaction of gas 

analyzer pumps to the expiration, and by indications of expiration and pulse LEDs. 

Pressing the “→” key will initiate measurement results storage in the memory. The test 

can be cancelled by pressing the “7” key. Data recording mode is indicated by the 

“Recording in progress” message. When this message is displayed, the terminal can be 

disconnected from the ergospirometer and the patient performs test tasks as planned. 

The test is terminated in the START 2000M ergospirometer by a command from the 

terminal. To do this, the terminal cable must be plugged into the “PC” socket of the 

ergospirometer. The test is terminated upon pressing the “7” key. When the test is 

completed, the device is ready to perform another test.  

 

13.2.3.2.4. Viewing the number of stored tests 

 

The START 2000M module can store up to 20 tests in “offline” mode. The 

number of currently stored tests can be viewed by pressing the “8” key. The terminal 



Operating manual for Start 2000M ergospirometer 

 54 

will then display the “Test number 00” message when there is no test stored in the 

memory, or “Test number XX”, where XX stands for the number of recorded tests. 

 

 

 

 

13.2.3.2.5. Clearing test memory 

The memory clearing function is available by pressing the “3” key. When the 

function is invoked, the “Clear?” message will be displayed. Confirming the operation 

by pressing the “→” key will erase the memory. The invoked function can be cancelled 

by pressing the “7” key. The memory cleaning operation is indicated by the “Clear” 

message which is displayed for a while, followed by the “START 2000M” message. 

 

13.2.3.2.6. Test results transmission 

The ergospirometer can store up to 10 tests in its internal Flash memory. The 

tests results are stored during the Offline and Online tests, with an option of viewing the 

data through high frequency link. To read the test results, the data of the patient who 

performed the test must be entered first. Next, select the Test results from unit command 

(Examination menu), or click the   button on the toolbar (see above). The software is 

now ready to retrieve the test results. Next, open the data retrieval dialog box by 

selecting the Data retrieve from the device command (Examination menu), or click the 

 button. The following dialog box will appear: 

 

          

13.33. Data retrieval dialog box 

The “Records containing test results” field contains the record numbers where test 

results are stored. Select the number corresponding to the desired test and click the 

Retrieve button. When the test results are read out correctly, the software will ask 

whether the user wants to save the selected test results. A positive answer invokes a 

window that saves test results (in the folder belonging to the selected patient). Together 

with the test results, the device transfers all calibration data relevant for the test results 
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being transferred (coefficients, date and time - on the right-hand side of the window), 

ambient conditions of the test (“Ambient conditions” field), and date and time of the test 

(“Date and time of the test” field). These data are updated in the window when the test 

results have been retrieved and they are used to calculate test parameters. At that 

moment they can be corrected manually if for any reason the data are incorrect. The 

system will not allow the user to leave the window with incorrect data in it. If the data 

are incorrect when the “OK” button is clicked, the system will indicate which data need 

correction and the window cannot be closed. The dialog window can be closed only 

when the data are correct. Test results will be then recalculated taking into account 

corrected ambient conditions data. The test can be then saved or the system will prompt 

about data that are not saved when the user attempts to leave the software. 

13.2.4. Spirometric examination. 

Selectin the Spirometric examination command from the Examination menu 

launches the LungTest 1000 programme with the previously entered patient data. The 

LungTest 1000 programme is described in a similar manual. 

13.2.5. Download parameters LT. 

After the selection of this command, a dialogue window appears as presented in pic. 

7.4. 
 

 

13.34. Spirometric examination parameters. 

In the left column there are names of examinations to be conducted to obtain the parameters 

from the middle column. In order to conduct a given examination, one should press the 

Conduct button. The LungTest 1000 programme is then launched in the mode suitable for 

the given examination. One should conduct the examination and the desired parameters will 

be transferred to the programme. 

13.3. Saving the examination to file. 

In order to save the examination results, select the Save examination command from 

the File menu. There appears a dialogue window with the question about the name of the 

file where we would like to save the examination. Standard extension of these files is *.egs. 

The programme creates automatically a subdirectory with the patient's personal data in the 

proper directory set in Examination options ( Chapter 11.2.5). The file name consists of 
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the date and time of conducting the examination. We may obviously change the name of the 

file and the directory where we want to save it. The file is saved upon closing the Save 

dialogue window with the OK button. If we try to close the programme without saving, the 

programme will remind us of the fact that the examination is not saved and enable us to 

save the examination before closing the programme.   

13.4. Opening examination from the file. 

The programme opens one type of files with the *.egs extension which include the 

saved examination. The examination saving process is described in chapter 7.3. In order to 

open the desired file, one should select the Open command from the File menu. When the 

dialogue window appears, select the file that we want to read. 
Upon opening the programme displays the diagram views and table with the parameters for 

the individual moments of examination. The number of views is set in Examination options 

-> Document view ( Chapter 11.3.1). The parameters displayed in the table are 

determined in the table view options ( Chapter 12.5.4). Because the values of all 

parameters from every moment of the examination are saved to the file, we may put any 

parameter in the table or on the diagram. In this way we have access to the diagram of every 

parameter and to its values at any moment of the examination. 

13.5. Printing the examination report. 

We may print the examination results after the examination completion or after 

opening the examination from file ( Chapter 7.4.). In order to print a report, one should 

select the Print command from the File menu or click on the printer icon in the toolbar. In 

order to survey the report layout, one should select the Printout preview command from the 

File menu. The printout may be set with the Print settings command from the File menu. 

The parameters of report layout may be set in Printout configuration. Its description can be 

found in chapter 7.5.2. 

13.5.1. Print settings. 

The Print settings command from the File menu launches the menu where we set 

the printout parameters. Here those parameters include: type of the printer with which we 

want to print the report, size and source of paper, page orientation. This window is 

presented in pic. 7.5. 
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13.35. Print settings dialogue window. 

13.5.2. Printout configuration. 

The layout options of the examination report are set in the window that appears after 

selection of the Printout configuration command from the Examination menu. It is 

presented in pic. 7.6. 
 

 

13.36. Printout configuration dialogue window. 

In the Name of institution fields we enter the name of institution that conducted the 

examination. The name will appear under the heading on the first page of the report ( 

Chapter 15). By marking the Colour printout field we inform the programme whether the 

printing will be in colour or not. If we do not mark this field, the programme will treat it as 
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printing in the grey scale. In such case every view with more than one diagram will be 

divided into so many separate diagrams as there was parameters determined in this view. 

Every selected parameter will be printed on a separate diagram. In the Number of diagrams 

on page field we determine how many diagrams should there be on one printout page. We 

confirm the set parameters with the OK button.  
In the Configuration field we select the printout elements. The maked modules will appear 

on the final printout. The buttons: 9 landscape report AT/CPET  and Additional diagrams 

AT/CPET are used for the AT/CPET report configuration (Chapter 15) . 



Operating manual for Start 2000M ergospirometer 

 59 

14. Mode of searching the AT threshold. 

In order to go to the mode of searching the AT threshold one should select the AT 

search command from the Tools menu or select the  from the toolbar. As a result the 

system displays three windows. 

 

14.37. View of the mode of searching AT. 

They display the value data of the examination parameters from the exertion phase (except 

for the first window which displays the data from the whole examination and the exertion 

area is marked with two orange vertical lines). The first window includes the diagram of 

maximum of four parameters in time. Those parameters may be selected freely in the same 

way as in the case of ordinary diagrams (the Parameters command from the diagram 

menu). The second window is the diagram of the relation of VCO2 and RER to VO2 

parameters. The third window displays one of the prepared parameter sets which is selected 

from the diagram menu (Parameters command). There is also a table displayed which, 

contrary to an ordinary table, has an orange heading. Upon selecting the AR search 

command the system automatically starts to search for the point closest to the AT threshold. 

In order to do this the programme uses the MES algorithm. If the threshold is determined, it 

will be marked on the diagrams and in the table. If the algorithm fails to determine the point 

corresponding to the AT threshold, the user will be informed about this fact.  
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If we want to determine the AT threshold on our own, the mode of searching the AT 

threshold offers us a lot of facilities. On the first diagram we have at our disposal an 

indicator (a vertical line) which we can move horizontally (along the time axis) with the 

mouse cursor (the indicator 'sticks' to the mouse cursor when the cursor moves onto the area 

of the first window). Moving the indicator within the exertion phases' area (two orange 

vertical line – only when the grid is displayed) on the second diagram the two regression 

straight line change their positions. They refer to the two data areas. Those areas are created 

by splitting all the data with a point marked with the indicator in the first window. The 

regression lines facilitate finding the maximum inflection point of the VCO2 in relation to 

VO2 diagram (point suspected of being the AT). Apart from the regression lines in the 

second window there is also an indicator (vertical line) drawn that determines the point 

corresponding to the place indicated in the first window. Such indicator is also drawn in the 

third window. Additionally, while moving the indicator, in the table there is marked in light 

orange a row corresponding to the indicated place. Also the table scroll is moved 

automatically so that the indicated row is displayed in the visible fragment of the table. In 

order to identify the place in the first window more accurately we can turn on the scroll. We 

do this as with the ordinary diagrams through double click on the area. We can turn the 

scroll off in the same way. With the indicator's movements there is integrated information 

about the phases displayed in the status bar. Hence we know in which phase the indicator is, 

how long it lasted and what the exertion was then. 

Both the first and third view can undergo configuration. For the first one we select 

the parameters like for the ordinary diagrams (the Parameters command from the view 

menu). For the third one the call is also made with the Parameters command, but here there 

will be displayed a window with parameter sets (like for the configuration, e.g. 9 landscape 

AT/CPET report). From this list we select one set of parameters.   

In order to mark in the chosen place the AT point, we select from the menu of the 

first view the Insert AT threshold command. The place is marked with an orange dashed 

line on every diagram and in the table the row is highlighted in orange. Additionally, on the 

second diagram the regression line of the first data area (data are split by the AT threshold) 

is drawn with this orange dashed line. The determined AT threshold is also marked in the 

table by highlighting the row in orange.   

After determining the AT threshold, we may print the report referring to this 

determination. In order to do this we mark the AT/CPET report option in the printout 

configuration. In order to print additional report diagrams one should also mark the 

Additional AT/CPET report diagrams button. The window is identical as for the 9 

landscape AT/CPET report (pic. 8.2). We select there two to four parameter sets. The sets 

for the 9 landscape report are selected after launching the window with the 9 landscape 

AT/CPET report window. During the 9 landscape report one needs to select nine sets.   
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14.38. Configuration of the 9 landscape AT/CPET report. 

Detailed description of the report from determining the AT threshold can be found in the 

next chapter: Examination report (Chapter 15). 
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15. Examination report. 

 
 

 

 

 

 

15.39. Examination report. 
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The user can decide the range of the printed report. According to chapter 7.5.2. and 

dialogue window in ill36, there is a possibility of report standard configuration for the user's 

purposes.  
The first page of the sample examination report is presented in pic. 9.2. Under the 

heading with the MES company logo as well as the ergospirometer name and the conducted 

examination, there is the name of institution that conducted the examination (if it was 

entered in the Printout configuration – Chapter 7.5.2.). Underneath there are data of the 

examined patient and the examination date. Then there are printed all the diagrams 

displayed in the diagram views. In case of black-and-white printout the views with more 

than one diagram are divided so that one view included only one diagram. After the 

diagrams there is the table drawn. If it exceeds the available width of the printout, on the 

pages dedicated to the table there is a message: Too little space to print the table. Then one 

should reduce the number of parameters in the table ( Chapter ). Before starting to print, 

it is recommended to check the printout preview (the Printout preview command from 

the File menu). In the report's footnote there are the parameters referring to the 

atmospheric conditions during the examination and information about the last gas and 

volume calibrations before the examination. ( Chapter 11.2).   
After the diagrams the table may be printed (pic. 9.2). It looks the same as in the 

programme window. 
 

 

15.40. Table on the printout. 

 

 

After the table there may be an additional report on the printout (pic. 9.3). 
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15.41. Additional report. 

Additional report includes the spirometric parameters valid for the given patient on the 

examination day, the maximum values for which norms apply (together with the norm 

values and percentage of deviation), the parameter values in the anaerobic threshold point, 

parameters of the oxygen debt and the name of programme phases if they were loaded from 

the file and not entered manually. If there are no spirometric parameters, suitable 

information will be placed there instead of them. Similarly in case of the oxygen debt if it is 

not calculated, there will be information displayed about the likely cause for this state of 

affairs. Usually, it is the lack of any phases in the examination. The parameters for which 

the maximum value norms apply are VO2, HR, BR, VE. 
 

Then there may be a metabolism report. The detailed description of it can be found in 

chapters .(Chapter 12.16) and .(Chapter 12.17). 

 

Then there may be a commentary to the examination (pic. 9.4) and chapter .(12.18). 
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15.42. Commentary on the printout. 

The next pages are the printout related to the AT threshold determination. Below there is 

the first page presented. 
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15.43. First page of the AT/CPET report. 

The first page of the report includes the cause the test termination, the spirometric 

parameters and average values of some parameters from the rest phase, maximum values 

from the exertion phases and values of the AT threshold. The window with the cause of test 

termination appears at the end of the examination if the proper option was marked in the 

Examination options. Additionally, this window may be displayed with the Cause of test 

termination command from the Tools menu. The cause of test termination is saved with the 

examination. Additionally, the table includes the SBP, DBP, Borg and lactate (Lct) 

parameters. The window to enter those values appears automatically during the examination 

when there is a phase change if the proper option was marked in the Examination options. 

One may call the window individually with the Enter SBP/ DBP/ Borg command from the 

Examination menu or clicking on the icon: . 
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15.44. AT report – 9 diagram view 

The second page may include nine diagrams selected from among twenty/ 

seventeen. The selection is made in the Printout configuration menu by clicking the 

Configuration of 9 view AT report button. From the displayed menu we mark 9 selected 

diagrams. 

 

 

 

 

 

 

 

On the third page of the report there are two views: V-Slope AT  
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and  Dual Criteria AT. The first one presents the diagram of VCO2 in relation to VO2. 

 

15.45. Third page of the AT/CPET report. 

It is the same diagram as the second diagram of the mode of searching AT, but here 

we do not have the RER parameter. The second view is the diagram of the parameters: 

EqO2, EqCO2, PeO2 and PeCO2 in relation to VO2. In those views there are additional 

columns with the expected range (light orange), the AT threshold is marked with an orange 

vertical line and the VO2 maximum value norms are displayed. On this page there are laso 

tables. The first one includes the percentage values of the VO2 parameters in the AT point 

in relation to the VO2 maximum value from the exertion phases and in relation to the VO2 

due. The second table is split to groups: metabolism, ventilation and gas exchange, 

parameter values in the AT points. If the AT threshold was not selected, the table will not 

appear and the Determined AT threshold caption will change into No determined AT 

threshold. On the next pages there may be additional diagrams selected in the printout 

configuration.  
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15.46. Additional diagrams of mode of searching the AT. 

We may print individual views in Mode of searching the AT. In order to do this, one should 

select the Print diagram command from the menu of the selected diagram view.  
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16. Menu commands. 

16.1.  File menu 

Patient's data  Chapter 10 

Open...  Chapter 7.4. 

Close Closes the opened examination. 

Save   Chapter 7.3. 

Save as .. Saves the examination result under the set name. 

Print...  Chapter 7.5. 

Printout preview  Chapter 7.5. 

Printout settings...  Chapter 7.5.1. 

Printout configuration...  Chapter 7.5.2.  

List of the recently opened files Includes the list of the recently opened files.  

Finish Ends the work with the programme 

16.2.  View menu. 

 

Toolbars Shows or hides the toolbar. 

Status line Shows or hides the status line ( Chapter 0). 

Data averaging...  Chapter 12.6 

Parameters displayed in the table.  Chapter 12.5.4 

ECG parameters  Chapter 6.12. 

Configuration of BMR norms  Chapter 12.16 

Calculate calorimetry  Chapter 12.17 

Stretching the Y diagram  Chapter 12.5.2.1 

Narrowing the Y diagram  Chapter 12.5.2.1 

Stretching the X diagram  Chapter 12.5.2.1 

Narrowing the X diagram  Chapter 12.5.2.1 

Default range of X scale  Chapter 12.5.2.4 

Synchronisation of diagram with 

the table 
 Chapter 12.5.4.6 

Synchronisation of table with the 

diagram 
 Chapter 12.5.2.2 

Synchronisation of diagrams with 

the diagram 
 Chapter 12.5.2.3 

Pop-Up window  Chapter 12.5.4.5 

 

16.3. Examination menu. 

Test in the laboratory   Chapter 13.2.1 

Test In the open air  Chapter 7.2.2. 

Spirometric examination  Chapter 7.2.3.  

Start Starts the examination ( Chapter 7.2.). 



Operating manual for Start 2000M ergospirometer 

 71 

Stop Ends the examination ( Chapter 7.2.). 

Start the test Starts the examination stage ( Chapter 7.2.). 

Connect ergospirometer  Chapter 7.2.2. 

Disconnect ergospirometer  Chapter 7.2.2. 

Enter event Enters event 12.3 

Edit event  Chapter 12.3 

Examination phases...  Chapter 12.2 

Ergometer control  Launches the remote control to control the ergometer ( 

Chapter 12.4).  

Commentary  Chapter 12.18 

Enter SBP, DBP, Borg, Lct 
 

 Chapter 14 

16.4.  Tools menu. 

Gas calibration   Chapter 11.2 

Volume calibration  Chapter 11.2.1 

Flow zeroing  Chapter 12.7 

Gas zeroing  Chapter 12.7 

Environment conditions  Chapter 11.1 

Equipment configuration  Chapter 11.2.2 

Examination options  Chapter 11.3 

Export to text file  Chapter 12.8 

Last parameters LT  Chapter 12.10 

Show dues  Chapter 12.11 

Print table  Chapter 12.5.4.7 

Determine AT threshold  Chapter 12.14 

Remove AT threshold  Chapter 12.15 

Cause of test termination  Chapter 8 

16.5. Help menu. 

About the 

programme  
Displays information about the programme: version number, copyright, 

etc.  
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17. Toolbar. 

17.1. Standard toolbar. 

 

17.47. Toolbar 

This toolbar includes the following buttons: 
 

 
Test in the laboratory Starts new examination ( Chapter 13.2.1) 

 
Test in the open air Starts new examination ( Chapter 7.2.2) 

 
Transmission an examination from 

devices 
Transmission an examination from devices( 

Chapter 7.2.2.2.6) 

 
Spirometric examination  Chapter 7.2.3 

 
Open  Chapter 7.4.  

 
Save   Chapter 7.3. 

 
Printout preview  Chapter 7.5. 

 
Print  Chapter 7.5. 

 
Export to statistical programmes  Chapter 12.8 

 
Volume calibration  Chapter 11.2.1 

 
Gas calibration  Chapter 11.2 

 
Atmospheric conditions  Chapter 11.1 

 
Flow zeroing  Chapter 12.7 

 
About the programme  Displays information about the programme: 

version number, copyright, etc. 

 
Stretching the Y diagram  Chapter 12.5.2.1 

 
Narrowing the Y diagram  Chapter 12.5.2.1 

 
Stretching the X diagram  Chapter 12.5.2.1 

 
Narrowing the X diagram  Chapter 12.5.2.1 

 
Default range of X scale  Chapter 12.5.2.4 

 
Synchronisation of diagram with the 

table 
 Chapter 12.5.4.6 

 
Synchronisation of table with the 

diagram 
 Chapter 12.5.2.2 

 
Synchronisation of diagrams with the 

diagram 
 Chapter 12.5.2.3 

17.2. Toolbar of the Test in the laboratory. 

 

17.48. Toolbar of the Test in the laboratory. 
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This toolbar includes the following buttons: 
 

 
Open  Chapter 7.4. 

 
Save   Chapter 7.3.  

 
Print  Chapter 7.5. 

 
Export to statistical programmes  Chapter 12.8 

 
Start Starts the control stage ( Chapter 7.2.) 

 
Start test Starts the examination stage ( Chapter 7.2.) 

 
 Stop Terminates the examination ( Chapter. 7.2.) 

 
Jump to next phase moves to the next phase of the actual protocol 

 
Enter event Enters event (Chapter 12.3) 

 
Ergometer control  Launches the remote control ( Chapter 12.4) 

 
Move to the last phase  Chapter 12.4 

 
Atmospheric conditions  Chapter 11.2 

 
Flow zeroing  Chapter 12.7 

 
Gas zeroing  Chapter 12.7 

 
About the programme  Displays information about the programme: 

version number, copyright, etc. 

 
Stretching the Y diagram  Chapter 12.5.2.1 

 
Narrowing the Y diagram  Chapter 12.5.2.1 

 
Stretching the X diagram  Chapter 12.5.2.1 

 
Narrowing the X diagram  Chapter 12.5.2.1 

 
Defaulf range of X scale  Chapter 12.5.2.4 

 
Synchronisation of diagram with the 

table 
 Chapter 12.5.4.6 

 
Synchronisation of table with the 

diagram 
 Chapter 12.5.2.2 

 
Synchronisation of diagrams with the 

diagram 
 Chapter 12.5.2.3 

 
Pop-Up window  Chapter 12.5.4.5 

 
Mode of searching AT  Chapter 8. 

 
Enter SBP, DBP, Borg, Lct  Chapter 8. 

17.3. Toolbar of the Test in the open air. 

 

17.49. Toolbar of the Test in theopen air. 

 

 

This toolbar includes the following buttons: 
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Open  Chapter 7.4. 

 
Save   Chapter 7.3. 

 
Print  Chapter 7.5.  

 
Export to statistical programmes  Chapter 12.8 

 
Start Starts the control stage ( Chapter 7.2.) 

 
Start test Starts the examination stage ( Chapter 7.2.) 

 
 Stop Terminates the examination ( Chapter. 7.2.) 

 
Disconnect ergospirometer   Chapter 7.2.2 

 
Connect ergospirometer  Chapter 7.2.2 

 
Clear the memory of ergospirometer   Chapter 6.9 

 
Flow zeroing  Chapter 12.7 

 
Gas zeroing  Chapter 12.7 

 
About the programme  Displays information about the programme: 

version number, copyright, etc. 

17.4. Toolbar of the Transmission of recorded examinations to 

PC. 

 

17.50. Toolbar of the Transmission of recorded examinations to PC. 

 
Save   Chapter 7.3.  

 
Print  Chapter 7.5.  

 
Export from ergospirometer Transmission an examination from 

ergospirometer Chapter 7.2.2.2.6 

 
Clear the memory of ergospirometer   Chapter 6.9 

 
About the programme  Displays information about the programme: 

version number, copyright, etc. 

Status line. 
The status line is at the bottom edge of the main application window ( pic. 11.5). 

Its position cannot be changed, however, the line may be hidden with the help of the Status 

line command (View menu). 
The status line displays explanations of menu commands and elements in the 

toolbars. In order to obtain the explanation, one place the mouse cursor upon the given 

element. 
During the examination with the use of ergometer control the line displays 

information about the number of all phases, the number of the current phase, phase duration 

time, time left to the end of the phase and time left to the end of examination.   
On the right of the status line there are three fields informing about the status of the 

following keys: CapsLock, NumLock and ScrollLock. 

 

17.51. Status line. 
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18. Maintenance and everyday service. 

1. Replace the content of the humidity absorber in the back part of the device after 

every hour of the device's work.  
2. After the finished work, remove the content of the tank from the humidity 

absorber.  
3. Before starting the examination and device calibration fill the tank of the humidity 

absorber.  
4. As the humidity absorber use the globule agent of the silicon gel. If the gel 

contains the colourful indicator, it should be blue before the humidity absorption 

and pink afterwards.  
5. Check the system of sponges at the outlets of the connection terminals of the 

humidity tank – they should be clean. The sponges can be cleaned in water and 

dried.  
6. Sponges in the humidity absorber tank should be always placed at the outlets of 

the connection terminals. 
7. The devices cannot be started without the sponges in the absorber tank.  
8. The masks always have to be clean, and the mask's channel – connected with the 

air cable – must be patent. 
9. The masks and the pneumotachographic heads should be changed after each 

examination so that the patient would receive sterile mask and head.  
10. The mask and mouthpiece sterilisation can be done in the gas steriliser or in 

liquids (CIDEX or ALDESAN). 
11. Sterilisation in liquids should be done through dipping the masks for 2 hours and 

then carefully washing them with distilled water and drying. The drying 

temperature cannot exceed 65C. 
12. After sterilisation in liquids and drying, the masks and heads should be checked in 

terms of the patency of the air channels.  
13. Grounding and potential levelling connections: Start 2000 is a device with the 

B2 anti-shock protection class. The device's grounding is not necessary, but it 

may be helpful in removing the interferences from the mains supply. The supply 

cable is equipped with the neutralising cable (the central pin in the port and plug 

of the supply cable). If the supply mains neutralisation is uncertain, then it is 

possible to connect the device to grounding in compliance with the IEC norm with 

the help of the grounding cable. The grounding cable should be connected to the 

device with the help of the grounding port on the back board of the device. Note. 

The grounding cables are not the potential levelling cables.  
14. Fuse replacement. Fuse of 1A 220V 50Hz is placed in the drawer port of the 

supply switch on the back board of the device. In order to replace the fuse, one 

should unplug the supply cable and then take out the fuse drawer. Note. One 

should only use fuses with parameters as given in the manual. 
NOTE!!! 
The above recommendations should be strictly followed! 
Non-observance of the above recommendations may damage the device, 

lead to erroneous results of the conducted tests and to  infect the 

examined person.  
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19. Appendix A 

 

19.1. O2 kinetics analysis 

 
VO2 kinetics, O2 deficit, O2 debt represent important determinants of exercise tolerance 

and sport performance. In "normal" conditions convective and diffusive O2 delivery to 

skeletal muscle fibers do not represent important determinants of VO2 kinetics. Thus, in 

"normal" conditions (e.g. normoxia, no impediments to O2 delivery, absence of 

pathological conditions) the limiting factors for VO2 kinetics seem mainly located within 

muscle fibers. Important determinants of skeletal muscle VO2 kinetics likely reside in the 

interplay between the various mechanisms of energy provision at exercise onset.  
The different "localization" of the main limiting factors for VO2 kinetics and VO2max 

offers to exercise physiologists the opportunity to perform, noninvasively, a functional 

evaluation of oxidative metabolism at two different levels of the pathway covered by O2, 

from ambient air to the mitochondria of exercising muscles. In other words by measuring 

VO2max we primarily evaluate the functional capacity by the cardiovascular system to 

deliver O2 to the exercising muscles, whereas when we determine VO2 kinetics the 

functional evaluation is mainly related to skeletal muscle oxidative metabolism. In 

pathological conditions the situation may be less clear. 
Does the concept outlined above apply also to pathological conditions? It is well known that 

pulmonary V O2 kinetics are slower than normal in patients affected by pathologies such as 

chronic obstructive pulmonary diseases, congestive heart failure, peripheral vascular 

diseases, type II diabetes.Does this mean that an impaired capacity by the lungs, heart, 

blood vessels to deliver O2 to the exercising muscles can be responsible for slower than 

normal VO2 kinetics? The answers to these questions is not straightforward. Evidence in 

favor of the concept that a limited capacity to deliver O2 to exercising muscles determines 

slower VO2 kinetics derives from experiments in subjects exposed to acute hypoxia, in 

subjects performing arm exercise, in subjects performing leg exercise in the supine, in 

subjects treated with bblockers. In all these conditions, slower pulmonary V O2 kinetics 

have been described, in association with (or as a consequence of) a reduced O2 delivery to 

the exercising muscles. On the other hand, it is being increasingly recognized that in 

patients with chronic cardiac, pulmonary, or blood vessel diseases, as well as in diabetic 

patients skeletal muscles are metabolically altered, and play a crucial role in determining 

the reduced exercise tolerance. Heart transplant recipients present slower pulmonary VO2 

kinetics, which, as a consequence of the denervation of the transplanted heart, are 

associated with slower heart rate and cardiac output kinetics.  
 

19.1.1. Onset  O2 kinetics 

Oxygen uptake response in the transition from rest to steady-state exercise. The oxygen 

uptake kinetic response can be defined by three phases or stages (Figure 1). 
 Phase I can be defined as the first twenty seconds of the metabolic response to exercise. 

Gaesser and Poole define phase I as increased VO2 primarily due to augmented cardiac 

output and pulmonary blood flow. The phase II kinetic time constant (τ) response is the 

time to reach 63% of Δ VO2 steady-state and is characterized by an exponential rise in VO2 
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just after the beginning of phase I . Increased venous return from the exercising muscle as 

well as continued pulmonary blood flow denote phase II kinetics. Gaesser and Poole (1996) 

also suggested that the phase II kinetic response is relatively constant in the transition  
from rest to steady-state during exercise of light to moderate intensity (below the lactate 

threshold). Moreover, increased levels of physical fitness (VO2 max) may lead to a 

faster τ. Also, τ may be delayed as a result of increased exercise intensity and probably 

facilitates an oxygen  drift.  

 

 

 
 

Figure1. 
VO2 response to constant-load exercise; the curved dashed line is the computer-derived 

representation of the best fit of the mono-exponential model to the VO2 response; the first dashed 

vertical line indicates onset of exercise and the second vertical line the end of exercise and initiate of 

recovery phase 

 
The phase II (τ) response is determined from the following equation: 

  

 VO2(t) = ΔVO2 x (1 - e–t/τ )  
where VO2(t) is the increase in VO2 above baseline VO2 at any time (t); 

Δ VO2 is the difference between phase I VO2 at the 20-second mark and steady-state 

VO2 (phase III);  

e is natural logarithm;  

τ is the time to reach 63% of ΔVO2. 

 

 

 

Value in START 2000M describing onset O2 kinetics: 

 

τ(63% ΔVO2) - τ is the time to reach 63% of ΔVO2 
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19.1.2. Recovery O2 kinetics 

At recovery, VO2 decreses exponentialy after a graded exercise. The half-time of VO2 

recovery (T0,5) has been shown to be 60-80s in normal subjects after graded exercise. The 

kinetics of VO2 is prolonged with the severity of heart failure.  Patients with  a VO2peak< 

10-12 ml/kg/min may need 3 min to decreaser their VO2 by 50%. This probably related to 

the slow kinetics of reconstitution of the energetic stores after exercise. This VO2 kinetics 

has the advantage of beaing only minimally influenced by the level of exercise; therefore, in 

case of submaximal exercise(at least when VO2>50% VO2max), VO2 kinetics can be used 

to analyse the degree of impaiment of circulatory function. A normal VO2 with a low VO2 

peak suggests submaximal exercise. The half time of VO2 recovery has prognostic value. 

 
Values in START 2000M describing recovery O2 kinetics: 

 

50% VO2peak[L] - value of 50% of VO2peak; 

T0,5VO2peak[s]-half time of recovery phase needs to 

decreaser VO2peak by 50% 

 

19.1.3. O2 deficit and O2 debt calculation 

 
The oxygen deficit is the difference between the total energy cost of work, assuming steady-

state throughout the entire exercise bout, and the measured portion of the total energy 

expenditure that was met during the exercise period by aerobic energy production . The O2 

deficit can be directly linked to steady-state VO2. Therefore, if steady-state is attained more 

rapidly a lower oxygen deficit would be noted. 

 

 
Figure2. 

Oxygen deficit and debt  during the constant-load exercise under Aneaerobic 

Treshold 
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VO2.T.SUM [L]  total quantity of oxygen used during the whole test; 
VO2.OD.SUM [L]  Onset Deficit Sum: difference between the product of steady state 

O2 uptake and work duration and the tptal O2 actually taken up by 

the body during the exercise. 
VO2.L.SUM [L]  total quantity of the consumed oxygen during the exertion  

  phases; 
VO2.R.SUM [L]  O2 debt: amount of O2 utilized, in the recovery phase of exercise, 

that is in excess of that required to maintain the recovery condition 

(usually rest or some low recovery work rate) in the steady state; 
VO2.A.SUM [L]  VO2.A.SUM = VO2.OD.SUM - VO2.R.SUM 
   anaerobic VO2 sum 

VO2.B.SUM [L]  quantity of oxygen used during the test calculated with the  

              consumption level from the reference phase; 

 
 

 

19.2. Description of CO2-Rebreathing Method 

Non-invasive determination of cardiac output (Indirect Fick Method) 
 

The basis for calculation cardiac output with the CO2 rebreathing method is a modification of 

Fick’s equation: 
  VCO2 = SV x HR x C(v-a)CO2 
 

and  Qa =SV × HR 
 

Cardiac output (Qa, measured in liters per minute) is the quantity of blood that is pumped by the 

heart each minute. It is the product of stroke volume (SV; the volume of blood ejected from the 

heart in a single beat, milliliters per beat) and heart rate (HR; expressed as beats per minute). 
FvCO2 determined by CO2 rebreathing is the most important task in the Indirect Fick Method 

the most important task because the mixed venous blood tension PvCO2 is reached 
 

  FvCO2=CO2 fraction during rebreathing 
 

FvCO2 represents equilibrated amount of CO2 in lung gas when output of CO2 is interrupted 

and it crrespondents to the mixed venous blood CO2 flowing into the lung vie the right heart. 
PvCO2 is calculated using equation 
 

  PvCO2(mmHg)=(B-47)xFvCO2/100 
 

The main feature of the method is that Qa value is determined by rebreathing instead of 

catherization. 
During steady state breathing, the subject is connected to a rebreathing bag from which he has 

to breath 5-12 times.There is a mixture of CO2(8-13%), O2(30-40%) and the remainder N2 in a 

5-liter bag. The CO2 concentration is adjusted to the workload and patient. The initial CO2 

concentration in the bag can be estimated from the result of the first rebrathing attempt on 

cardiac patient but it is possible to predict the initial concentration accurately on healthy 

subjects.  
Patient breaths normally a few minutes until ventilation and circulation are in steady-

state.Steady-state can be determined by observation of a constant time course for FeCO2, RER, 

FetCO2 and VCO2/VE. 
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At the end of an exhalation the subject is connected to a rebreathing bag using manual three-

way valve(or automaticall valve in START 2000 system).If an equilibrium is reached between 

the blood and gas phase, the value of mixed CO2 fraction FvCO2 measured in the bag 

represents the required PvCO2. During rebreathing process, gas is continually sampled at the 

mouth and analyzed in the CO2 analyzer. The CO2 concentration-time curve, showed in real 

time on the PC monitor, reflects the balancing process  
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It is necessary to do 2-3 rebreathing tests, even with young ,healthy patients but you have to 

wait 2-5 minutes between each rebreathing test because the arterial blood-gas values have to be 

stabilized again( ventilation and circulation should be in steady-state). 
Arterial CO2 content can be obtained by converting arterial PCO2 using the CO2 dissociation 

curve. 
The oxyhemoglobin dissociation curve, specifically, the oxyhemoglobin dissociation curve 

relates oxygen saturation (SO2) and partial pressure of oxygen in the blood is an important tool 

for calculating procedure. 
 

Parameters: 
Fet CO2  (%)  end-tidal CO2 fraction 
FeCO2   (%)  average expiation CO2 fraction 
VCO2   (l/min)  emission of CO2 
RQ     respiratory quotient 
HR   (1/min)  heart rate 
PaCO2   (mmHg) arterial CO2 pressure 
PaO2   (mmHg) arterial O2 pressure 
Hb   G/100ml haemoglobin 
pHa     arterial pH 
Btemp   0C  body temperature 
FvCO2   (%)  mixed venous CO2 fraction 
PvCO2   (mmg)  venous CO2 pressure 
SaO2   (%)  arterial O2 saturation 
CaO2   (vol%)  arterial O2 content 
C(v-a)CO2  (%)  venous arterial CO2 content difference 
C(a-v)O2  (vol%)  arterial venous O2 content difference 
CvCO2   (vol%)  venous CO2 content 
CaCO2   (vol%)  arterial CO2 content 
Qa   (l/min)  cardiac output 
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SV   (ml)  stroke volume 
HI   (1/min/m2) heart index 
SVI   (ml/m2) stroke volume index 
CI   (l/min/m2) cardiac output index 
VE   (l/min)  ventilation 
VA   (l/min)  alveolar ventilation 
VDf/VE    dead-space ventilation ratio 
VA/Qa      alveolar ventilation cardiac output ratio 
Load   WATT 
 


